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Foreword

Congratulations on your choice of a Branson Metal Welding system!

The Branson VersaGraphix Series system is process equipment for the joining of metal
parts using ultrasonic energy. It is the newest generation of product using this
sophisticated technology for a variety of customer applications. This Operating Manual is
part of the documentation set for this system, and should be kept with the equipment.

Thank you for choosing Branson!

Introduction

This manual is arranged into several structured chapters which will help you find the
information you may need to know to safely handle, install, set up, program, operate,
and/or maintain this product. Please refer to the Table Of Contents of this manual to find
the information you may be looking for. In the event you require additional assistance or
information, please contact our Product Support department (see 1.4 How to Contact
Branson for information on how to contact them) or your local Branson representative.
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1.1 Safety Requirements and Warnings

This chapter contains an explanation of the different Safety Notice symbols and icons
found both in this manual and on the product itself and provides additional safety
information for ultrasonic welding. This chapter also describes how to contact Branson for
assistance.

1.1.1 Symbols found in this Manual

These symbols used throughout the manual warrant special attention:

WARNING Indicates a possible danger

If these risks are not avoided, death or severe injury might result.

CAUTION Indicates a possible danger

If these risks are not avoided, slight or minor injury might result.

NOTICE Indicates a possible damaging situation

If this situation is not avoided, the system or something in its vicinity
might get damaged.

Application types and other important or useful information are
emphasized.

1.1.2 Symbols found on the Product

The VersaGraphix Ultraweld L20 has several warning labels on it to indicate the presence
of hazardous voltages inside the unit.
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1.2 General Precautions
Take the following precautions before servicing the VersaGraphix:

Be sure the power switch is in the Off position before making any electrical connections

To prevent the possibility of an electrical shock, always plug the VersaGraphix into a grounded
power source

Power supplies produce high voltage. Before working on the VersaGraphix module, do the
following:

e Turn off the VersaGraphix;
e Unplug main power; and
¢ Allow at least 2 minutes for capacitors to discharge.

High voltage is present in the VersaGraphix Ultraweld L20. Do not operate with the cover
removed

High line voltages exist in the ultrasonic VersaGraphix module. Common points are tied to circuit
reference, not chassis ground. Therefore, use only non-grounded, battery-powered multimeters
when testing these modules. Using other types of test equipment can present a shock hazard

Be sure power is disconnected from the VersaGraphix before setting a DIP switch

Keep hands from under the horn. Down force (pressure) and ultrasonic vibrations can cause
injury

Do not cycle the welding system if either the RF cable or converter is disconnected

WARNING

Sound level emissions of up to 84.9 dB have been measured using a
standard test load. To prevent the possibility of hearing loss, use
appropriate hearing protection.

NOTICE

Sound level and frequency of the noise emitted during the ultrasonic
assembly process may depend upon a. type of application, b. size,
shape and composition of the material being assembled, c. shape
and material of the holding fixture, d. welder setup parameters and
e. tool design. Some parts vibrate at an audible frequency during the
process. Some or all of these factors may result in sound levels of up
to 84.9 dB. In such cases operators may need to be provided with
personal protective equipment. See 29 CFR (Code of Federal
Regulations) 1910.95 Occupational Noise Exposure. For all other
countries, follow your local regulations.
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NOTICE

Because the Branson SBC Ultraweld L20 runs on a Windows 10 IoT

Enterprise LTSC? based PC Platform, it is susceptible to computer
viruses. Reasonable steps have been taken to protect our software
but all customers are advised to take all necessary steps to ensure
that no virus contamination occurs. Do not attempt to run any
applications other than the Branson SBC Ultraweld L20 application. If
you chose to connect the SBC controller to a computer network,
added precautions must be taken in the form of firewalls, etc. No
liability will be accepted for any loss or damage sustained as a
consequence of any virus transmission.

a.

Windows 10 loT Enterprise LTSC is a registered trademark of Microsoft Corporation.

1.2.1 Intended Use of the System

The Branson VersaGraphix Ultraweld L20 and Actuator are components of an ultrasonic
welding system. These are designed for a wide variety of welding or processing
applications.

1.2.2 Regulatory Compliance

The Branson products (VersaGraphix Ultraweld L20 Welders) are designed to be in
compliance with the following U.S. regulatory and agency guidelines and standards:

ANSI Z535.1 Safety Color Code
ANSI z535.3 Criteria for Safety Symbols
ANSI Z535.4 Product Safety Signs and Labels

ANSI Z535.6 Product Safety Information in Product Manuals, instructions, and other collateral
materials

NFPA 70 National Electric Code Article 670 Industrial Machinery
NFPA 79 Electrical Standard for Industrial Machinery

UL 61010-1

CSA 22.2 No. 61010-1

29 CFR 1910.212 OSHA General Requirements for all machines
47 CFR Part 18 Federal Communications Commission

Branson products (VersaGraphix Ultraweld L20 Welders) are designed to be in compliance
with the following listed European standards as specified by the Directives issued by the
European Parliament and The Council of the European Union:

Machinery Directive 2006/42/EC
Low Voltage Directive 2014/35/EU
EMC Directive 2014/30/EU

BS EN ISO 13850 Safety of Machinery - Emergency stop equipment, Functional aspects -
Principles for design

EN 13849-1 Safety of Machinery - Safety of related parts of control systems
EN ISO 12100 Safety of Machinery - Risk assessment - Part 1: Principles

EN 55011 Limits and methods of measurement of radio disturbance of industrial, scientific and
medical radio-frequency equipment

EN 60204-1 Safety of Machinery - Electrical Equipment of machines

EN 61000-6-2 Electromagnetic Compatibility - Generic standards - Immunity for industrial
environments

DCMO00060 REV. 13
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e EN 61310-2 Safety of Machinery - Indication, marking, actuation
All products with CE Mark require: Same as above plus

Branson products (VersaGraphix Ultraweld L20 Welders) are designed to be in compliance
with relevant UK Statutory Instruments and their amendments:

*Supply of Machinery (Safety) Regulations 2008
*Electromagnetic Compatibility Regulations 2016

All products with UKCA Mark require: Same as above plus

UK
CA

DCM00060 REV. 13 5
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1.3 Warranty

For warranty information please reference the warranty section of Terms and Conditions
found at: www.emerson.com/branson-terms-conditions.
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1.4 How to Contact Branson

Branson is here to help you. We appreciate your business and are interested in helping
you successfully use our products. To contact Branson for help, use the following
telephone numbers, or contact the field office nearest you.

* Brookfield Main Number (all Departments): (203) 796-0400 (Eastern Time Zone)

e Parts Store: Direct Number for Parts Store in Brookfield (203) 796-9807

Tell the operator which product you have and which person or department you need. If
after hours, please leave a voice message with your name and return telephone number.

1.4.1 Before Calling Branson for Assistance

This manual provides information for troubleshooting and resolving problems that could
occur with the equipment (see Chapter 6: Maintenance). If you still require assistance,
Branson Product Support is here to help you. To help identify the problem, use the
following questionnaire which lists the common questions you will be asked when you
contact the Product Support department.

Before calling, determine the following information:

1. Your company name and location.
2. Your return telephone number.

3. Have your manual with you.
4

Know your equipment model and serial numbers (found on a gray data label on the units).
Information about the Horn (part number, gain, etc.) or other tooling may be etched into the
tooling. Software- or firmware-based systems may provide a BIOS or software version number,
which may be required.

What tooling (horn) and booster are being used?
What are the setup parameters and mode?
Is your equipment in an automated system? If so, what is supplying the “start” signal?

©® N oW

Describe the problem; provide as much detail as possible. For example, is the problem
intermittent? How often does it occur? How long before it occurs if you are just powering up? If
an error is occurring, which error (give error number or name)?

9. List the steps you have already taken.

10. What is your application, including the materials being processed?

11. Have a list of service or spare parts you have on hand (tips, horns, etc.)
12. Notes:

DCM00060 REV. 13 7
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1.5

1.5.1

1.5.2

Returning Equipment for Repair

NOTICE

To return equipment to Branson, you must first obtain an RGA
number from a Branson Metal Welding representative, or the
shipment may be delayed or refused.

If you are returning equipment to Branson for repair, you must first call the Repair
department to obtain a Returned Goods Authorization (RGA) number. (If you request
it, the repair department will fax a Returned Goods Authorization form to fill out and
return with your equipment).

Branson Metal Welding Repair Department
120 Park Ridge Road

Brookfield, Connecticut 06804 U.S.A.
direct telephone number: (203) 796-0807
fax number: (203) 796-0574

¢ Provide as much information as possible that will help identify the need for repair
e Carefully pack the equipment in original packing cartons

¢ Clearly label all shipping cartons with the RGA number on the outside of cartons as well as on
your packing slip, along with the reason for return

e Return general repairs by any convenient method. Send priority repairs by air freight
e You must prepay the transportation charges FOB Brookfield, Connecticut, U.S.A.

Get an RGA Number
RGA#

If you are returning equipment to Branson, please call the Repair Department to obtain a
Returned Goods Authorization (RGA) number. (At your request, the Repair Department
will fax an RGA form to fill out and return with the equipment).

Record information about the Problem

Before sending equipment for repair, record the following information and send a copy of it
with the equipment. This will greatly increase Branson’s ability to address the problem.

1. Describe the problem; provide as much detail as possible.
For example, is the problem intermittent? How often does it occur? How long before it occurs
after powering up?

2. Is your equipment in an automated system? NO / YES

DCMO00060 REV. 13
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3. If the problem is with an external signal, which signal?
If known, include plug/pin # (e.g., P29, pin #3) for that signal:

4, What are the Weld Parameters?

5. What is your application? (Type of weld, metal material, etc.)

6. Name and phone number of the person most familiar with the problem:

7. Contact the Branson Metal Welding office prior to shipping the equipment.
8. For equipment not covered by warranty, to avoid delay, include a Purchase Order.

Send a copy of this page with the equipment being returned for repair.

1.5.3 Contact Information

Call your local Branson Metal Welding Representative, or contact Branson by calling (203)
796-0400.

My Local Branson Representative's name is:

I can reach this representative at:

1.5.4 Pack and Ship the Equipment

1. Carefully pack the system in original packing material to avoid shipping damage. Plainly show
the RGA number on the outside of cartons as well as inside the carton along with the reason for
return. Make a list of all components packed in the box. KEEP YOUR MANUAL.

2. Return general repairs by any convenient method. Send priority repairs by air freight. Prepay the
transportation charges FOB the repair site (either the Branson field office or Brookfield,
Connecticut USA location).

NOTICE

Items that are sent Freight Collect will be refused.

DCM00060 REV. 13 9
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1.6 Obtaining Replacement Parts
You can reach the Branson Parts Store at the following telephone numbers:
¢ Direct Telephone Number: (203) 796-9807
e Fax number: (203) 926-2678
Many parts can be shipped the same day if ordered before 2:30 p.m., Eastern time.
A parts list is found in Chapter 6: Maintenance of this manual, listing descriptions and EDP
part numbers. If you need replacement parts, coordinate the following with your
purchasing agent:
e Purchase order number
e ‘Ship to’ information
e 'Bill to’ information
e Shipping instructions (air freight, truck, etc.)
e Any special instructions (for example, “Hold at the airport and call”). Be sure to give a name and
phone number
e Contact name information
10 DCMO00060 REV. 13
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2.1 About this Operating Manual

This manual provides detailed instructions for the setup, operation, and maintenance of
the Branson VersaGraphix Ultraweld L20. For detailed information on operation and
maintenance of other components connected to the Ultraweld L20, refer to appropriate
Actuator instruction manual.

The VersaGraphix Ultraweld L20 contains a microprocessor-based controller that provides
for control and monitoring of welding operations.
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2.2 Model Covered

This document is intended for use with a 2032S actuator. This document is intended for
use in conjunction with others to form a complete manual for your Branson Metal Welding

system. Please refer to the _Table Of Contents of this Instruction Set to find specific
information.

DCM00060 REV. 13 13
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2.3

Overview of this Model

The Branson welder generates ultrasonic electrical energy through an ultrasonic converter
for welding metals. Several models are available, depending on the desired frequency (for
example, 20 kHz) or the desired power range (for example, 2.2 kW). The VersaGraphix
also contains a microprocessor-based controller module that provides for control and
monitoring of welding operations.

14
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2.4 Compatibility with Branson Products
The Branson VersaGraphix Ultraweld L20 is designed to be used with:

¢ Branson Metal Welding Actuators: 2032S, Ultrasplice 40, Ultrasplice XL, Auto Terminator,
Ultraweld L20, WSX ERGO, and Ultraseal 20

¢ Branson Metal Welding converters: see Table 2.1 VersaGraphix Ultraweld L2 mpatibility with

Branson Metal Welding Converters below

Table 2.1 VersaGraphix Ultraweld L20 compatibility with Branson Metal Welding Converters

Branson Model

20 kHz/1250 W
20 kHz/2500 W
20 kHz/3300 W
20 kHz/4000 W

Converter

503, 105

20 kHz/5000 W

High Power

40 kHz/400 W
40 kHz/800 W

4T], 4TR, 4TH

DCM00060 REV. 13
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2.5
2.5.1

2.5.2

2.5.3

2.5.4

Ultrasonic Theory
What Is An Ultrasonic Weld?

Ultrasonic welding joins metal parts by applying the energy of high frequency vibrations
onto the interface area between the parts to be welded.

How Does It Work?

Electrical Energy is transformed into high frequency mechanical vibration. This mechanical
vibration is transferred to a welding tip through an acoustically tuned horn. The parts are
“scrubbed” together under pressure at 20,000 or 40,000 cycles per second. This high
frequency vibration, applied under force, disperses surface films and oxides, creating a
clean, controlled, diffusion weld. As the atoms are combined between the parts to be
welded, a true, metallurgical bond is produced.

Figure 2.1 How does Ultrasonic Welding Work?

POWER SUPPLY FORCE
I @
|
VWA \V\/\ 50/60 Hz VIBRATION
2040 khz HORN &K&W
ELECTRICAL ENERGY WELD INTERFACE
= MECHANICAL ENERGY
4@ [] ANVIL

TRANSDUCER BOOSTER HORN

WA

Benefits of Ultrasonic Welding

Ultrasonic metal welding exhibits unique welding properties that include:

e Excellent electrical, mechanical, and thermal connections between similar and dissimilar metals
e Low heat build up during the ultrasonic process (no annealing of materials)

e Compensation for normal surface variations of the material

e Ability to clean surface oxides and contaminants prior to welding

e Ability to weld large areas using minimal energy

e Ability to weld thin materials to thick materials

e Low cost per weld

How Is An Ultrasonic Weld Made?

Although the theoretical process of producing an ultrasonic weld is uncomplicated, the
interactions of the various weld parameters are important and should be understood.
When producing an ultrasonic weld, there are three primary variables that interact; they
are:

e Time: The duration of applied ultrasonic vibration

e Amplitude: The longitudinal displacement of the vibration

* Force: The compressive force applied perpendicular (normal) to the direction of vibration

16

DCMO00060 REV. 13



BRANSON

The power required to initiate and maintain vibration (motion) during the weld cycle can
be defined as

Table 2.2  Calculating Power

Where:
e P = Power (watts)
P=FxAXxf e F = Force * (N)

e A = Amplitude (microns)
e f = Frequency (Hertz)

NOTICE
Force = (Surface Area of the Cylinder) X (Air Pressure) X (Mechanical Advantage)

Table 2.3  Calculating Energy

Where:

e E = Energy (joules)
e P = Power (watts)
e T = Time (seconds)

E=PxT

Thus the complete *‘Weld To Energy’ process would be defined as:

E=(FxAxf)xT

A well designed ultrasonic metal welding system will compensate for normal variations in
the surface conditions of the metals by delivering the specified energy value. This is
achieved by allowing Time (T) to adjust to suit the condition of the materials and deliver
the desired energy.

2.5.5 Welding To Energy - Why?

Most metal welding applications are produced by ‘Welding To Energy’ in order to
compensate for the various surface oxides and contaminants associated with the metals
being joined. In a few applications ‘Welding To Time’ or ‘Welding To Height’ will yield better
results. Since the majority of all metal welds are produced using energy as the controlling
factor we will confine our discussion to that condition.

Welding to energy is necessary because of the non-metallic oxides that form on the
metal’s surface as well as other contaminates such as grease and dirt. To produce quality
welds reliably it is necessary that the surfaces to be joined are clean. The high frequency
scrubbing action, combined with pressure, cleans the weld interface at the beginning of
the weld process.

The following graph (Figure 2.2 Weld Power Graph for Clean Components, Dirty
Components, and when Part is Missing) illustrates a weld produced. The weld ‘power
graph’ is sometimes referred to as weld ‘footprint’. It can be used to visualize the weld
cycle and assists in parameter optimization. Graphs from consecutive welds will vary
slightly as the system dynamically adjusts time to accommodate varying surface
conditions. The weld power data is gathered by sampling the power used in 5 millisecond
intervals.
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2.5.6

Figure 2.2 Weld Power Graph for Clean Components, Dirty Components, and when Part is Missing

Clean Component Parts
(Area under curve = 1,000 joules)
Quick ramp up to peak power and
short cycle time to dissipate energy
|:| Dirty Component Parts and or Worn tooling
(Area under curve = 1,000 joules)
Slow ramp up to peak power and longer
cycle time to dissipate energy
Component Part Missing
100 — |:| (Area under curve = 500 joules)
No ramp up to peak power and long cycle time to
dissipate energy. Cycle terminated after 5 seconds.

20 3.0 4.0 5.0
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Power

The converter/booster/horn, (stack assembly), requires minimal electrical power to
initiate and maintain motion (vibration) at a ‘no-load’ condition. As the mechanical load
increases, the power required to maintain the mechanical vibration also increases. The
maximum power required during a weld cycle is ‘Peak Power’.

By increasing Pressure and maintaining all other parameters, the mechanical load or force
on the weld joint increases, therefore, the amount of Power required to maintain the
vibration of the stack increases. Subsequently, because of the increased Power Level, less
time is required deliver the same amount of Energy. This relationship is illustrated on

Figure 2.3 Pressure Variable with Increased Power.
Figure 2.3 Pressure Variable with Increased Power
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The difference in the appearance of each of the above weld graphs is the result of
increased Power loading. Based upon an increase in Pressure, additional Power is required
to maintain the motion of vibration. Thus, the same amount of energy is delivered in less
time. This approach is typically used to raise the loading of the power supply during a weld
cycle to the desired level as determined by the application.

18
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2.5.7 Time

The time required to deliver the necessary energy is defined as the Weld Time. For most
welds, the time required will be less than one second. If more energy is required and all
other weld parameters are maintained, the weld time will increase (Figure 2.4 Pressure
Variable with Increased Time).

Figure 2.4 Pressure Variable with Increased Time
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2.5.8 Amplitude

An ultrasonic tool is a resonant acoustical device. The term Amplitude is used to describe
the amount of longitudinal expansion and contraction that the tooling endures as it
vibrates (Figure 2.5 Scrubbing Action on Weld Interface). The amplitude correlates to the
scrubbing action at the weld interface. This scrubbing action combined with pressure is
what advances the weld by a diffusing or mixing of the base materials.

Figure 2.5 Scrubbing Action on Weld Interface
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As previously mentioned, the converter/booster/horn, (stack assembly), requires minimal
electrical power to initiate and maintain vibration in a ‘no-load’ condition. As the amplitude
increases, the power required to maintain the increased velocity of vibration also
increases. Subsequently, because of the increased Power less time is required deliver the
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same amount of Energy. This relationship is illustrated in the following power diagram
(Figure 2.6 Amplitude’s Influence on Weld Power and Time):

Figure 2.6 Amplitude’s Influence on Weld Power and Time
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2.5.9 Amplitude Stepping

In standard practice, the scrubbing amplitude at the weld interface is maintained constant
during a weld cycle. Recent advances in technology have made it possible to change the
amplitude of the horn face during the weld cycle. This is known as Amplitude Profiling.
Figure 2.7 Amplitude Stepping Profile illustrates a typical profile where the amplitude is

reduced during the cycle. This type of profile is used mostly with welding aluminum to
increase weld strength and to help prevent sticking to the tooling.

Figure 2.7 Amplitude Stepping Profile
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2.5.11

2.5.12

2.5.13

BRANSON

Resonant Frequency

The ultrasonic tooling acts as a spring having node points and anti-node points. The
mechanical energy used to vibrate the tool is created by the converter. As the vibrations
are propagated through the acoustical tool, a harmonic resonance is established
consisting of nodes and antinodes. This action results in a resonant wave being
transferred through the tooling (Figure 2.8 Harmonic Resonance on Ultrasonic Tooling).
The efficiency of the resonant wave transfer depends on the natural resonant frequency of
the horn and is determined by two factors:

e The speed of sound through the material
e The geometric shape of the object

Figure 2.8 Harmonic Resonance on Ultrasonic Tooling
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Avoiding An Overload Condition

It is possible to increase the Amplitude and or the Pressure to a point where the power
available is not adequate to initiate or maintain vibration under the given mechanical load.
At this point, the power supply will stall resulting in an Overload condition. Electronic
circuits in the system will protect the power supply if this condition exists.

Welding To Time

In specific applications, ‘Welding To Time’ may be desired. As previously mentioned, there
are three primary variables that interact; they are:

e TIME: The duration of applied ultrasonic vibration

e AMPLITUDE: The longitudinal displacement of the vibration

e FORCE: The compressive force applied perpendicular (normal) to the direction of vibration

Generally, welding for a specific time will produce acceptable results when:

e The equipment is installed on an automated production line and each station must complete its
process within a certain time limit

e \Very small low energy welds on clean components are being made

Welding Temperature

Ultrasonic welding produces a localized temperature rise from the combined effects of
elastic hysteresis, interfacial slip and plastic deformation. The weld interfaces reach
approximately 1/3 the temperatures needed to melt the metals. Since the temperature
does not reach the melting point of the material, the physical properties of the welded
material are preserved. As the ultrasonic welding process is an exothermic reaction, as
welding time increases so does weld temperature.
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2.6

Terminology

Actuator: A mechanical device which houses the converter/booster/horn (stack)
assembly in a rigid mounting and is utilized to move the stack up or down. This allows for
precise control of welding pressure while delivering mechanical vibrations from the
ultrasonic stack to the work piece(s).

After Burst: A short duration (burst) of ultrasonic energy that begins after the weld is
complete and at 1mm from the final height reading. Used when the splice nugget is
sticking to the tooling.

After Burst Delay: The amount of time, in seconds, between the completion of the
ultrasonic welding cycle and the start of the AFTER BURST. (Also see AFTER BURST).

Amplitude: Amplitude is the peak-to-peak displacement of mechanical motion as
measured at the face of the horn tip. Amplitude is measured either in thousandths of an
inch or in microns (e.g. a standard 40 kHz Converter produces approximately .0004” or 10
microns of amplitude), Inches x 25.4 = microns. -- This is adjustable depending on
system frequency and application tooling.

Anti-Node: The anti-node is the area of the horn and booster that exhibits maximum
longitudinal displacement and where the internal dynamic forces are equal to zero. This
area is at the face and back surface on half-wave technology.

Anvil: A device specially designed to grip the lower component and hold it stationary
against the energy of vibration(s) which allows a weld to be created.

BBR: Nonvolatile random access memory (battery back-up random access memory).
Equipped with long life built in batteries, this memory area preserves weld parameters
and menu settings when the system is powered off. (Also known as BRAM).

Booster: The central component of an ultrasonic stack assembly. A device which transfers
mechanical energy from the Converter to the ultrasonic horn. The booster will, depending
on design, increase, decrease, or maintain the specific amplitude as received from the
converter.

Calibration: The process of adjusting a device to a known position for purposes of
inspection and/or monitoring position, direction, speed, and/or velocity.

Consumable Spare Tooling: The tooling portion of the ultrasonic system that wears and
requires replacement due to production use. This includes but is not limited to ultrasonic
horns, replaceable tips, anvil, and positioning mask. A Spare Tooling Specification Sheet is
included within the Actuator Operation Manual to document the spare tooling for a specific
metal welding application.

Ultraweld L20: The portion of the welding system that provides specific settings &
instruction(s) to the overall welding system.

Converter: A device which utilizes a PZT (lead-zirconate-titanate) electrostrictive element
to change high frequency electrical energy into high frequency mechanical energy.

Counter: A programmable device used to monitor system cycles and alert personnel
when specific conditions are met.

Data: Any representation(s) of instructions, characters, information, or analog quantities
to which meaning may be assigned.

Default: A chosen system setting or parameter in which the system does not require
external data input. In some cases the default value will be changed based upon
equipment use.

Dynamic Spring: An, adjustable, energy storage mechanism (shock absorber) which
allows for stack follow through upon engagement of application tooling with the work
pieces to be welded.

22
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Energy: Energy is the area beneath the ultrasonic power curve and is calculated in joules,
(Watts X Seconds = Joules). When the ultrasonic welding system is setup in the "Weld In
Energy” mode the system will deliver the amount of energy as programmed. NOTE: The
maximum (default) time allowed for delivering ultrasonic energy is five (5) seconds.

Energy Mode: A welding method in which the ultrasonic power supply is active until the
required amount of energy is delivered (see ENERGY).

Fixture: A device for positioning and or holding a component for assembly.

Force: The amount of mechanical pressure that is used to deliver (bring down) the
mechanical actuator. This programmed force is also called TRIGGER FORCE and is used to
engage the knurl pattern into the component part(s) prior to the initiation of ultrasonic
energy.

Frequency: The number of complete oscillations per second expressed in Hertz (Hz) or
kilohertz (1 kilohertz = 1000 Hz). Typically 20 kHz or 40 kHz.

Gain: The ratio of the amplitude of motion produced by the Converter and delivered by
the horn is called the gain. It is determined by the difference in mass on either side of the
nodal point.

Height: A value, in millimeters (mm), as registered by a linear encoder upon completion
of an ultrasonic welding cycle. -- Programmable, in millimeters, with Upper Control Limit &
Lower Control Limit.

Height Encoder: A device utilized to monitor position, direction, speed, and/or velocity.

Horn: An acoustically designed metal tool that delivers mechanical energy from the
converter/booster into the work piece. Most applications utilize half wave technology.

Hold Time: The amount of time after delivery of ultrasonic energy until the stack tooling
begins to retract from the component material(s).

Joint: The area where the surfaces are welded together.
Linear Height Encoder: See Height Encoder.

Loading Meter: A meter which indicates the power drawn from the ultrasonic power
supply.
Maintenance Counter: Used to alert production personnel of the need to review/ inspect

application tooling and/or the ultrasonic system for preventive maintenance purposes.
(See Counters).

Mode: The method of operating the system (also see WELDING MODE).

Node: The node is the area of the horn, (and booster), that exhibits no longitudinal
displacement and where the internal dynamic forces are at the maximum. This area is in
the center location on half-wave technology.

Parameter(s): Programmable units used to control and or monitor the ultrasonic
process. --Include but not limited to ENERGY, FORCE, PRESSURE, AMPLITUDE.

Parts Counter: Used to monitor system cycles and alert personnel when specific
conditions are met. (See Counters).

Peak Power: Peak power is the maximum amount of power in watts that was required to
keep the ultrasonic stack in motion during the weld cycle.

Power: Power, measured in watts, is a function of pressure and amplitude. The amount of
power, (watts) required to keep the ultrasonic stack in motion is monitored and used to
develop a power curve. This power curve is used to calculate the amount of energy
delivered/ dissipated, (Watts = Joules/Time). The power as displayed on the control box is
peak power.
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Power Supply (Ultrasonic): An electronic device that converts 50/60 cycle electrical
current into 40 kHz, (40,000) or 20 kHz, (20,000) cycles per second high frequency
electrical energy.

Power Supply Overload (Ultrasonic): The point or limit at which the amount of power
in watts, required to keep the ultrasonic stack in motion, exceeds the available power from
the power supply. The system will go into an overload condition in order to prevent system
damage.

Pre-Burst: A short duration (burst) of ultrasonic energy that begins after the Squeeze
Time and before capturing the Pre-Height. Used when welding magnet wire. It helps to
break up the insulation around the copper, and provide a small cooling period before the
weld takes place.

Pre-height: A pre-sonic inspection display, in millimeters (mm), as registered by a linear
encoder prior to initiation of the ultrasonic welding cycle. -- Programmable, in millimeters,
with Upper Control Limit & Lower Control Limit.

Presets: Welding parameters stored in the controller memory.

Pressure: The amount of mechanical pressure supplied to the ultrasonic stack assembly
while delivering ultrasonic energy to the components.

Quality Widows & Limits: Programmable values used by the system to compare actual
process data. Actual process data must be within limits or an alarm be issued.

Quick After Burst: Once this option is enabled, the after burst needs to be implemented
immediately after each weld cycle finished without any time delay or condition judgment.

Squeeze Time: The amount of time after the ultrasonic tooling engages the
component(s) and before delivery of ultrasonic energy. -- Adjustable from 0 - 2 seconds.

Stress: Stress is the amount of dynamic force per cross sectional area.

Time: Time is the duration of the ultrasonic, mechanical, activity. Time is a component
used to calculate the amount of ultrasonic energy delivered during a weld cycle, (Time =
Joules/Watts).

Tip: Device specially designed to grip the upper component, to be welded, and to direct
the ultrasonic energy into the work piece, (Also Horn Tip & Replaceable Horn Tip).

Tip Nut: Device specially designed to securely clamp a replaceable tip onto the horn.
Trigger Force: See Force.

Tuning: Adjusting to optimize power supply performance according to resonance
frequency, especially with regard to the horn and converter.

Velocity: The rate of motion at a specific time [velocity = distance time] Also referred to
as speed.

24
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3.1 Shipping and Handling

CAUTION

The VersaGraphix Ultraweld L20’s internal components are sensitive
to static discharge. Many components can be harmed if the unit is
dropped, shipped under improper conditions or otherwise
mishandled.

3.1.1 Environmental Specifications

The VersaGraphix Ultraweld L20 is an electronic unit that converts line voltage to
ultrasonic energy and controls user input for regulating the weld process. Its internal
components are sensitive to static discharge, and many of its components can be harmed
if the unit is dropped, shipped under improper conditions, or otherwise mishandled.

The following environmental guidelines should be respected when shipping the
VersaGraphix Ultraweld L20 and Touchscreen Monitor:

Table 3.1  Environmental Requirements

Environment Range

Storage / Shipping Temperature -139 Fto +131° F (-25° C to +55° C)

Shock / Vibration (Transit) 22,‘?Msgggk2{808-2r?da;§8(03-_91000 Hz) vibration per

Humidity 30% to 95%* non condensing

*Above 40° C the humidity drops to 90%
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3.2 Receiving

The VersaGraphix Ultraweld L20 is a sensitive electronic device. Many of its components
can be harmed if the unit is dropped or otherwise mishandled.

CAUTION

The Actuator and the VersaGraphix Ultraweld L20 are heavy.
Handling, unpacking, and installation might require assistance or the
use of a lifting device.

Scope of Delivery

Branson units are carefully checked and packed before dispatch. It is recommended,
however, that you follow the inspection procedure below after delivery.

To inspect the VersaGraphix Ultraweld L20 when it is delivered, take the
following steps:

Table 3.2

Step
1

Inspect the VersaGraphix upon delivery
Action

Verify that all parts are complete according to the packing slip.

2

Check the packing and the unit for damage (visual inspection).

3

Report any damage claims to your carrier immediately.

4

Determine if any component has become loose during shipping and, if
necessary, tighten screws.

NOTICE

If the goods delivered have been damaged during shipping, please
contact the forwarding agent immediately. Retain packing material
(for possible inspection or for sending back the unit).

CAUTION

The Actuator and the VersaGraphix Ultraweld L20 are heavy.
Handling, unpacking, and installation might require assistance or the
use of a lifting device.

DCM00060 REV. 13
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3.3 Unpacking

The VersaGraphix is fully assembled. It is shipped in a sturdy cardboard box. Some
additional items are shipped in the box with the Ultraweld L20.

When unpacking the Ultraweld L20, take the following steps:

Table 3.3 When unpacking the Ultraweld L20

Step Action

1 Unpack the VersaGraphix Ultraweld L20 as soon as it arrives. Save the
packing material.

2 Inspect the unit for signs of damage.

3 Remove the cover of the VersaGraphix Ultraweld L20 (see Section 6.3 Parts
Replacement) to check if any components became loose during shipping.

4 Store or ship the VersaGraphix Ultraweld L20 only within a temperature
range of -13° F to +1319 F (-25° C to +55° C).

NOTICE

If damage has occurred, notify the shipping company immediately.
Retain packing materials for inspection.
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3.4 Returning Equipment

If you are returning equipment to Branson, please call your Branson Metal Welding
Representative or Customer Service to receive approval to return goods to Branson.

5 Returning Equipment for

If you are returning equipment for repair refer to Section 1.
Repair of this manual, for appropriate procedure.
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4.1

Environmental Requirements

The VersaGraphix Ultraweld L20 and Touchscreen Monitor have the following

Environmental Requirements:

Table 4.1 Environmental Requirements

Environmental Concern TERTEL (Lt Touchscreen
Supply
Ambient Operating +410 Fto +1220F +320 F to +104° F
Temperature (+5° Cto +50° O) (0° C to +40° C)
Storage / Shipping -139Fto +131°0F -40 F to +131°F
Temperature (-259 C to +550° C*) (-200 C to +55° C)
o) 0/, Xk
Humidity 30% to 95%**non 30% to 80%
condensing

Operating Altitude 1000 m (3280 ft) 3658 m (12000 ft)
IP Rating 2X

*70° C for 24 hours
**Above 40° C the humidity drops to 90%
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4.2 Electrical Requirements

The following tables list input voltages, current requirements, and fuse requirements for
the VersaGraphix Welding System, and includes power required when it is used with

Branson Metal Welding Actuators.

Table 4.2  Electrical Input Operating Voltages

Power Supply Rating Nominal Input Operating Voltage, +/- 10%
20 kHz / 2200 W 200-230 V, 50/60 Hz, Single Phase
20 kHz / 3300 W 200-230 V, 50/60 Hz, Single Phase
20 kHz / 4000 W 200-230 V, 50/60 Hz, Single Phase

Table 4.3  Input Current and Fuse Requirements
Model Input Current Fuse Requirements

2200 W 200V - 230V 14 Amp Max. @ 200V / 20 Amp fuse

For 20 kHz Models 3300 W 200V - 230V 21 Amp Max. @ 200V / 20 Amp fuse
4000 W 200V - 230V 25 Amp Max. @ 200V / 25 Amp fuse
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4.3 Pneumatic Requirements

The factory compressed air supply must be “clean (to a 5 micron level), dry and
unlubricated” air with a regulated maximum pressure of 80 psig (5.5 bar).

34 DCMO00060 REV. 13



BRANSON

4.4 Operating System

The VersaGraphix Ultraweld L20 uses an embedded Single Board Computer (SBC) to offer
advanced user interface functions. It uses Windows 10 IoT Enterprise LTSC as its

operating system.

4.4.1 About Microsoft Windows 10 IoT Enterprise LTSC

While Windows 10 IoT Enterprise LTSC is similar to the standard desktop version of
Windows 10 there are some differences that the advanced user should be aware of.

To protect the application and the operating system, Windows employs a Unified Write
Filter Utility (UWF). This filter uses a RAM overlay to record changes to the Solid State
Drive. Any changes made to the C: drive are lost during a power cycle. Only the
C:\AmtData folder remains unprotected allowing the VersaGraphix application to write
directly to the C: drive in order to save presets, sequences, setup parameters and log

files.

The UWF must be disabled before modifying the Windows configuration. Changes made to
Windows configuration such as printer driver installation or Local Area Network
configuration will be lost if the UWF has not been previously disabled. Once all changes
have been saved, the UWF must be re-enabled before resuming controller operations.
Enabling and disabling the UWF goes beyond the scope of this application user manual.

Contact customer support

Information).

NOTICE

Operating the system while the UWF is disabled will not allow the

application to save presets, sequences, setup parameters and log file

information.

if this becomes necessary (see section 1.5.3 Contact

DCM00060 REV. 13

35



BRANSON

36 DCMO00060 REV. 13



BRANSON

Chapter 5: Operation

5.1 BeforeYouBegin...........oiuuuuunnnsssnssssnsnsnnssnnnnnnns 38
5.2 PopUpAlphanumericKeypad ... ... ittt sennannannsnnsnnnns 39
53 PopUpNumericKeypad ..... ...ttt ennrtsnnnnssnnnnnnnnnnsss 40
54 EditingButtons ............ciiiiiernn st nssssassnnsnnnnnnnns 41
55 PullDOWNMEeNUS. .. ... :ounrsnnnnsssnnnnsnnnsssnnnnsssnnnss 42
56 CreateNew Preset........... ittt enrenrannsnnsnnsnnsnnsns 46
5.7 CreateNew Sequence ... ..... .. cuuu s nnnnssannssnnnnsssnnnns 48
58 EditSequence ...... ..ttt et anrsnnsna s sansansnnnnnnnnnns 50
5.9 FileManager ... ... ...ttt nnnnsnnssssssssansnnssnnnnnnns 52
5.10 RUNMENU. .t 1ttt st s s s n s s n s an s ansnnsansnnsnnnsonsnnsnnsnnsss 55
5.11 OptionsMenu ......... ittt enrsnnsnnsansansansnnnnnnnnnss 66
5.12 RemoteDataCollection. . . ... ... ittt rennnssnnnnnnnnnnsns 73
5.13 ViewMenuU. .....:itttiinnnsnsnnnnsnnnsssannnsssnnnsnnnnssss 77
5.14 HelpMenu .. ... ..t ittt ittt st st st s nsnnsnnnsansnnsnnsnnsns 81
515 Language Support . . . ... .. i i it s s s s e 82

DCM00060 REV. 13 37



BRANSON

5.1 Before You Begin

High voltage might be present in the Branson VersaGraphix Ultraweld
L20 (VersaGraphix). When setting up and operating the welding
system, observe the potential hazards listed below.

¢ Do not operate the VersaGraphix with the cover removed

e To prevent the possibility of electric shock, always plug the VersaGraphix Ultraweld L20 into a
grounded power source

e Do not cycle the welding system if either the RF cable or the converter is disconnected. High
voltage could be present at open power connections

e Ensure power switch is in the OFF position before making or breaking any electrical or pneumatic
connections to the VersaGraphix and/or Welder

e Do not touch Ultrasonic Horn during or immediately following the welding cycle. Vibrations and
heat can burn skin
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5.2 Pop Up Alphanumeric Keypad

Figure 5.1 Pop up Alphanumeric Keypad
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A pop up keypad will be displayed on the touchscreen when it is necessary to enter
alphanumeric data using the touchscreen. This keyboard includes upper case letters A
through Z, numbers 0 through 9, space, backspace, enter, clear and cancel. It also
includes the following symbols: ! @ # $% ~ & () - =/ + and,.

Using non permitted characters when naming a preset or a sequence may happen if you
use an external keyboard. To avoid system errors due to invalid name, please refer to the
alphanumeric characters in the image above when naming a preset or a sequence with an
external keyboard.
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5.3 Pop Up Numeric Keypad

Figure 5.2 Pop up Numeric Keypad
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A numeric keypad will pop up on the touchscreen when it is necessary to input numeric
data. This Keypad includes buttons for the numbers 0 through 9, decimal point, Backspace
(<<--), ENTER, CLEAR, and ESC. It also has a +10% button and a -10% button, which
are used to enter values +/- 10% of the currently set value, allowing quicker setups.
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5.4 Editing Buttons
‘ Edit

Edit When the “Edit” is highlighted, it allows you to edit sequences.
Delete
X When the “Delete” button is highlighted, you may remove
unwanted sequence steps. On the file manager screen the
“Delete” buttons allows you to eliminate unwanted files in the
Browse and Application folders.
Enter
+~ Touching the “Enter” button saves changes.
Copy
Copy When highlighted, the “Copy” button allows you to create a copy
of a sequence step.
Escape
Esc Touching the “Escape” button undoes the previous change.
Copy To
Copy>> ‘ “Copy To” buttons are available on the File Manager screen. You
may use them to copy files between the Browse and Application
folders.
Move To
Move>> ‘ “Move To” buttons are available on the File Manager screen. You
may use them to move files between the Browse and Application
folders.
Select All
Select All ‘ “Select All” buttons are available on the File Manager screen. You

may use them to Move, Copy, or Delete at once all files in the
user’s or Branson’s Application folders.
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5.5

5.5.1

5.5.1.1

5.5.1.2

5.5.1.3

5.5.1.4

Pull Down Menus

Use the pull down menus at the top of each screen to navigate between different screens.
The title of each screen appears in the screen's title bar.

File Menu

Figure 5.3 File Menu

['E Configuration Settings
File Run
Create New Preset

Option:

Create New Sequence

Edit Sequence

r

Save Preset

Save Preset As

File Manager

Create New Preset

Select Create New Preset to input new weld Preset names into the controller. The Presets
will be saved into the controller's library with default preset values. You may then proceed
to the Setup screen to enter the preset’'s weld parameters. See Section 5.10.3 Setup
Screen (When Running a Preset) for more information on entering weld parameters.

Create New Sequence

Select Create New Sequence to input weld sequences. A sequence is a series of grouped
weld presets which are to be executed in a particular quantity and order. Sequences are
constructed using existing weld presets stored in the Ultraweld L20's library.

Edit Sequence

Touching this option will take you to the Edit Sequence screen where you can modify
Sequences.

Save Preset

When a preset is modified on the Setup Screen, the preset is modified in running memory.
An ' * ' symbol is appended to the preset name to indicate that the preset has not been
saved. By selecting Save Preset, changes to the preset that is currently running on the
Ultraweld L20 are made permanent. This also causes the ' * ' to disappear from the preset
name.

NOTICE

Unless the preset is saved by selecting Save Preset, all unsaved setup
changes will be lost when loading a different preset, closing the
VersaGraphix application, or powering off the VersaGraphix Ultraweld
L20.
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5.5.1.5 Save Preset As

By selecting Save Preset as you can create a copy of the preset currently running on the
Ultraweld L20. You will be prompted to supply a new preset name. This new preset will be
automatically loaded to memory.

5.5.1.6 File Manager

Selecting File Manager will take you to the Branson File Manager screen. From this screen
files can be moved and copied between your directories and Branson's Application
Directory. You can also delete files from either your own folders or from Branson's
application folders.

5.5.2 Run Menu

Figure 5.4 Run Menu

ﬁrﬁ Configuration Settings
File Run Options Vit
Operator Screen

New Preset

New Sequence
Actuator:|D al

Setup Screen

sel1€ach Mode Screen
= N

5.5.2.1 Operator Screen

Touching this button will take you to the operator screen. You can choose the Operator
Screen to be the start screen when you turn on your controller. For information see

Section 5.11.1.5 System Configuration.
5.5.2.2 New Preset

Select New Preset to load a preset from the Ultraweld L20's library. After selecting a
preset the Operator Screen will be displayed.

5.5.2.3 New Sequence

Select New Sequence is used to load a Sequence from the Ultraweld L20's library. After
selecting a sequence the Operator Screen will be displayed.

5.5.2.4 Setup Screen

When running a preset, select Setup Screen to change individual weld parameters which
are the basic elements required to make a weld. See Section 5.10.3 Setup Screen (When
Running a Preset) for more details on entering weld parameters.

When running a Sequence, the Setup Screen can be used to monitor results for each weld.
Weld parameters cannot be edited when running a sequence.

You can choose the Setup Screen to be the start screen when you turn on your controller.
For information see Section 5.11.1.5 System Configuration.

DCM00060 REV. 13 43



BRANSON

5.5.3

5.5.3.1

5.5.3.2

5.5.3.3

5.5.4

5.5.4.1

Options Menu

Figure 5.5 Options Menu

['E Dperator Screen

File Run Options View
Part# Configuration
Amtra~hk 9TT i
Maintenance
Administrator

Configuration

Select this option to access the Configuration screen where Ultraweld L20 features can be
setup. These features include: Actuator model; default weld settings; Teach Mode
settings; System Configuration; and COM settings.

Maintenance

Select this option to access the Maintenance screen. This screen allows adjustment and
on-demand control of motion devices used in the actuator. This screen also allows access
to the maintenance log, maintenance counters, and limit settings.

Administrator

Select this option to access the Administrator screen. From this screen you can exit the
Ultraweld L20 program; determine if Windows should shut down at exit; rename auxiliary
buttons; enable password requirement; edit the Administrator and Technician passwords;
and set screen permissions.

NOTICE

The default password is ADMIN.

View Menu

Figure 5.6 View Menu

[E Dperator Screen

File Run Options View Help
Part# | Weld Graph c
Amta~h 4T
| Statistical Analysis ]
«
— ErrorLog -
Weld History

Weld Graph

Selecting this option will display a popup window with a graph showing how the last weld
developed over time.
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5.5.4.3

5.5.4.4

5.5.5

5.5.5.1

5.5.6

BRANSON

Statistical Analysis

Select this option to view weld result data for Time, Power, Pre-Height and Height in
relation to their quality windows.

Error Log

Selecting this option will take you to the Error Log window. In this window the date/time,
part name, error type and value for unsuccessful welds can be viewed and printed.

Part History

Select this option to view and/or print weld results.

Help Menu

Figure 5.7 Help Menu

[ﬁ Dperator Screen
File Run Ontions View Help
Part# About Versagraphix

Ak mal o7

About VersaGraphix

Select About VersaGraphix to display the VersaGraphix’s software version, and Ultraweld
L20 version.

Branson Logo

Touching the Branson logo in any of the screens will cause the Language Settings window

to pop up.

Figure 5.8 Branson Logo

BRANSON
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5.6 Create New Preset

Table 5.1 Create New Preset

Step Action

1 Select Create New Preset from the File Menu.

[‘E Configuration Settings

File Run

Option

Create New Sequence

Edit Sequence

Save Preset

Save Preset As

File Manager

Step Action

Touch the field next to Preset Name. (An alphanumeric keyboard will pop up).
Input the preset name (20 characters max).

[ save Preset

File Run Options View Help
Preset Name ‘ PRESET 1 | BRANSON

Teach Mode

v Global [ Special

Insert Pic + Esc
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Step Action

Select either Global or Special Teach Mode settings for your preset. Global
3 Settings are set on the Teach tab in the Configuration Screen. For more
information, see Section 5.11.1.3 Teach Mode Settings.

Touch the Insert Pic button to include an image to be displayed on the
Operator screen as a visual aid for manufacturing.

5 Press the Enter button to save the preset.

Presets will be saved into the controller's library with default preset values. You may then
proceed to the Setup screen to enter the preset’s weld parameters. See Section 5.10.3

Setup Screen (When Running a Preset) for more information on entering weld

parameters.

DCMO00060 REV. 13 47



BRANSON

5.7 Create New Sequence

Table 5.2 Create New Sequence

Step Action
1 From the File menu select Create New Sequence.
File Run Option
Create New Preset
Edit Sequence
Save Preset
Save Preset As
File Manager
Step Action
2 Touch the field next to Sequence Name. (An alphanumeric keyboard will
pop up). Input the sequence name (20 characters max).

Help

File Run Options View
BRANSON
Sequence Name |
B Seq. Name: SRS
PRESET1 POS.—-Splice Part Wame Run-Qty |NEW SEQUENCE
PRESET10 SECOND SEQUENCE
PRESET11
PRESETZ
PRESET3
PRESET4 Add>>
PRESETS
PRESETH
PRESET?
PRESETS
PRESETS \
f Sequence Name THIRD SEQUENCE|
!@‘a‘s%ﬂ&‘()‘-‘= << 7|89
Q‘W‘E‘R‘T Y‘U‘I‘O‘P‘ CLEAR 4 |5 |6
A‘S‘D‘F‘G‘H‘J‘K‘L‘ ENTER 1 2 |3
Z‘X‘C‘V‘B‘N‘M‘ ‘ ‘I‘ESC 0‘+
) [
Edit | P =410 TUPY T
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Step Action
Touch the ADD>> button then choose a Preset from the Parts list to add a
3 step. A numerical keyboard will pop up. Enter the number of welds for the
step. Each step in a sequence can support multiple welds of a single weld
preset.

['E Create New Sequence
File Run Options View H

File Run Options View Help

BRANSON
THIRD SEQUENCE

Sequence Name T

Seq. Name: THIRD SEQUENCE

Sequences

[ [NEW SEQUENCE
62 |SECOND SEQUENCE

ol =|a|~
o
Alaw|lo|o

Maximum Value 1000

R Dk hehokl

Parts

PRESET1 POS.--Sp.
PRESET1

PRESETI

PrESET? y —
PRESETA4 ( Add>> ||
PRESETS
PRESETE Edit > «
PRESET? — |

PRESETS

Esc Copy Print

NOTICE

Touching the Insert button allows user to insert steps. After touching
the Insert button select a part from the Parts list. Then touch the
position above which you wish to insert it. A numeric key pad will pop
up. Enter the amount of welds you wish to make and press enter to
insert the step.

Insert>>
Step Action
4 Once sequence has been completed touch the Enter button to save it. The

VersaGraphix supports up to 250 presets per sequence.
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5.8 Edit Sequence

Existing Sequence presets may be edited from the Edit Sequence Screen.

Table 5.3 Edit Sequence

Step Action

1 From the File menu touch the Edit Sequence.

['E Configuration Settings

File Run Option
Create New Preset

Create New Sequence

Save Preset

Save Preset As
File Manager

Step Action

2 Touch the Edit button so that it is highlighted. Select the Sequence preset
to be edited from the preset library.

I Edit Sequence

File Run Options View Heln
BRANSON

Parts Sequences

PRESET1 NEW SEQUENCE
PRESET10 SECOND SEQUENCE
PRESET11
PRESET2
PRESET3
PRESETA
PRESET5
PRESET6H
PRESET?
PRESETS
PRESETS

Edit >< « Esc Copy Print
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Step Action
A list box with the sequence's steps will appear in the middle of the window.
3 The steps may now be edited (go to Section 5.7 Create New Sequence for
more information on sequences).
4 Press the enter button to save the changes.
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5.9 File Manager

Figure 5.9 File Manager screen

File Run Options View Help
BRANSON
Browse Directory Application Directory
‘Qa: j
[=TY
‘AAmtData
PRESET10 prt PRESETI prt
PRESETS prt PRESET11 prt
PRESETS prt PRESET2 prt
Copy>> || pRESETS prt
PRESET4.prt
<<Copy ||PRESET7prt
PRESETS.prt
PRESETS prt
Move>>
<<Move
Select All e ‘ | selectAl | o

The File Manager screen is used to maintain data files used by the application. You may
copy Presets, Sequences and History files to and from the VersaGraphix to other storage
devices such as USB memory sticks, and external network drives. The Application
Directory box shows the files that are available to the application. They are stored in a
fixed directory structure as shown. The user’s browsing on the controller files is limited to
these three directories:

Presets: C:\AmtData\Apart\Prstname.prt
Sequences: C:\AmtData\Aseq\Segname. seq

Log Files: c:\AmtData\history\Wename. tsv

5.9.1 Copying Files To The Application

Table 5.4 To copy files from the Application Directory to the Browse Directory

Step Action
1 Touch the <<Copy button, so that it is highlighted.
2 Touch the file(s) on the Application Directory that you wish to copy into
the Browse Directory.

Table 5.5 To copy files from the Browse Directory to the Application Directory

Step Action

1 Touch the Copy>> button, so that it is highlighted.
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Table 5.5 To copy files from the Browse Directory to the Application Directory
Step Action

Touch the file(s) on the Browse Directory that you wish to copy into the

2 Application Directory.

NOTICE

Only files of types .prt, .seq, and .tsv can be copied using the file
manager. They will automatically be put into the appropriate
application library directory.

5.9.2 Moving Files

Table 5.6 To move files from the Application Directory to the Browse Directory
Step Action

1 Touch the <<Move button, so that it is highlighted.

Touch the file(s) on the Application Directory that you wish to move into

2 the Browse Directory.

Table 5.7 To move files from the Browse Directory to the Application Directory
Step Action

1 Touch the Move>> button, so that it is highlighted.

Touch the file(s) on the Browse Directory that you wish to move into the

2 Application Directory.

NOTICE

Moving files works the same as Copying with the exception that the
source file is deleted after the transfer.
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5.9.3 Deleting Files

Table 5.8

Step

1

To delete files from the either the Application Directory or the Browse Directory

Action

Touch the Delete button under the appropriate directory, so that it is
highlighted.

Touch the files you wish to delete (You will be prompted to confirm).

Select Yes to delete the file.

Repeat steps 2 and 3 for all the files you wish to delete.

NOTICE

If you Touch the Select All button when the Delete button is
highlighted you will be prompted to confirm the deletion of all the
files in the directory.
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5.10.1
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Run Menu
The Run pull down menu contains the following choices:

Operator Screen (When Running a Preset)

Figure 5.10 Operator screen (When running a Preset)

A 0perator Screen X
File Run Options View Help

Part#
Amtoch 5U | |  cyees-o | ==B>|  gpanson

| Part Count =0 || End Count=0 | 7812010
3:59:09 PM

Height  + - Pre-Height + = Time + 8 Power +

H BE R Bl .

This is the Operator Screen when running a preset. You can choose this screen to be the
start screen when you turn on your controller. For information see Section 5.11.1.5
System Configuration.

Displayed on the upper section of the screen are the Preset’'s name, the part counter (Part
Count), cycle counter (Cycles), and the batch size (End Count). The cycle counter keeps
track of the amount of welds performed. When the Part Counter equals the End Count the
controller will ask if you want to reset the part counter to zero. Touch the Part Count or
the Cycles button to reset the cycle or part counter. Touch the End Count button to enter
a new batch size.

Touch the red arrow to switch between the Operator and Setup screens.

When running a preset on the Operator Screen, changes made to the End Count are kept
in memory only. The preset hame will display a' * ' symbol to note that the preset has not
been saved. If a different preset is loaded, the VersaGraphix application is closed, or the
VersaGraphix Ultraweld L20 is powered off, unsaved changes will be lost. To save the End
Count change to the preset file, select Save Preset from the File menu, or select Save
Preset As to save the changes into a new preset file.

NOTICE

Unless the preset is saved by selecting Save Preset, all unsaved setup
changes will be lost when loading a different preset, closing the
VersaGraphix application, or powering off the VersaGraphix Ultraweld
L20.
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NOTICE

If an image was selected for the preset, it will be displayed on the
middle of the screen.

On the bottom of the screen you can see the quality indicators. These indicate visually if
the Height, Pre-Height, Time, and Power readings fell within the acceptable range for
the last weld. They each have three sections. The section in center is the pass section and
it will light green when the parameter reading fell within the acceptable range. The left
and right sections are, respectively, the fail low, and fail high sections. These sections will
light red when the parameter reading fell outside the acceptable range. The controller will
also display a pop up window with an alarm message for unsuccessful welds.

Figure 5.11 Result is taller than maximum height message

5.10.2 Operator Screen (When Running Sequence)

Figure 5.12 Operator screen (When running a Sequence)

A Operator Screen X

File Run Options View Help
Part#
Amtech SU | | Cycles=0 || = | BRANSON
ggg*{ | Part Count =0 | End Count =233 S G—
4:23:27 PM
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This is the Operator Screen when running a sequence. You can choose this screen to be
the start screen when you turn on your controller. For information see Section 5.11.1.5

System Configuration.

Displayed on the upper section of the screen are the sequence’s nhame, the current step’s
Preset name, the part counter (Part Count), cycle counter (Cycles), the step’s batch size
(End Count) and the current step number. The cycle counter keeps track of the total
amount of welds performed while the part counter keeps track of the welds performed for
the current step. Touch the Cycles button to reset the cycle counter. Touch the red arrow
on the upper right side of the screen to go the next step on the sequence.

NOTICE

If an image was selected for the preset, it will be displayed on the
middle of the screen.

On the bottom of the screen you can see the quality indicators. These indicate visually if
the Height, Pre-Height, Time, and Power readings fell within the acceptable range for
the last weld. They each have three sections. The section in center is the pass section and
it will light green when the parameter reading fell within the acceptable range. The left
and right sections are, respectively, the fail low, and fail high sections. These sections will
light red when the parameter reading fell outside the acceptable range. The controller will
also display a pop up window with an alarm message for unsuccessful welds.

Figure 5.13 Result is smaller than minimum height message

Eﬂ Alarms
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5.10.3 Setup Screen (When Running a Preset)

Figure 5.14 Setup screen (When running a Preset)

File Run Options View Help

Part#

Aaeen SO | | cyees=o | m=be| pRanson
| Part Count=0 | | End Count=0 | TR

Weld Settings 12:44:32 PM

Setting Actual

Ws 1240 | fl240
TP.  582Psi | 58.2Psi
WP.  sg2psi | F8.2Psi
- s [P

Advanced Settings ‘
Quality Settings
Setting Actual

e
e
15.00mm | f52mm ®

0.00mm

0.00mm

This screen can be used to setup and fine-tune your weld presets. On this screen you can
run and edit Weld, Advanced, and Quality settings for your currently loaded preset. You
can choose this screen to be the start screen when you turn on your controller. For
information see Section 5.11.1.5 System Configuration.

Displayed on the upper section of the screen are the Preset’s name, the part counter (Part
Count), cycle counter (Cycles), and the batch size (End Count). The cycle counter keeps
track of the amount of welds performed. When the Part Counter equals the End Count the
controller will ask if you want to reset the part counter to zero. Touch the Part Count or
the Cycles button to reset the cycle or part counter. Touch the End Count button to enter
a new batch size.

Touch the red arrow to switch between the Operator and Setup screens.

In the middle of the screen on the left side are the Weld Settings Box, the Advanced
Settings button, and the Quality Settings box. On the right side of each quality parameter
a circle is displayed. The circle will light green for successful welds and red for
unsuccessful welds. If an image was selected for the preset, it will be displayed on the
screen. The controller will also display a pop up window with an alarm message for
unsuccessful welds:

Figure 5.15 Result is taller than maximum height

[’f_a Alarms
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While on the Setup Screen, when running a preset, all changes made to a preset setup are
kept in memory only. The preset name will display a ' * ' symbol to note that the preset
has not been saved and a Save Preset Button will appear in the lower-left section of the
screen. If a different preset is loaded, the VersaGraphix application is closed, or the
VersaGraphix Ultraweld L20 is powered off, unsaved changes will be lost. To save the
setup changes to the preset file, touch the Save Preset button, select Save Preset from
the File menu, or select Save Preset As to save the changes into a new preset file.

NOTICE

Unless the preset is saved by selecting Save Preset, all unsaved setup
changes will be lost when loading a different preset, closing the
VersaGraphix application, or powering off the VersaGraphix Ultraweld
L20.

5.10.3.1 Weld Settings

In the Weld Settings box you can see the actual readings for the last weld on the
rightmost column. You may alter the parameter settings by touching the buttons on the
center column. The parameters:

Watt/seconds (Ws): The amount of energy (in joules) delivered on each weld.

Trigger Pressure (T.P): The clamping pressure that needs to be exerted to the parts
before applying ultrasonic energy.

Weld Pressure (W.P): The clamping pressure applied to the parts during a weld.

Amplitude ( {—\ﬁ— ): The amplitude (in microns) of the applied ultrasonic vibration. If an

amplitude stepping mode has been selected on the Advanced Settings window, you will be
able to enter Amplitude A, Amplitude B, and a Step Point.

5.10.3.2 Quality Settings

In the Quality Settings box you can see the actual readings for the Time, Energy, Pre-
Height, and Height of the last weld. You may also adjust the acceptable range for the
following quality parameters.

Time(@) max/min: The max/min time that the ultrasonic energy may be applied to
a weld.

Energy(;) max/min: The max/min power which may be applied to a weld.

Pre-Height() max/min: The max/min height of the parts before welding. This is a
pre-welding inspection reading from the height encoder.

Height () max/min: The max/min height of the resulting weld.
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5.10.3.3 Advanced Settings Screen

Figure 5.16 Advanced Settings screen
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This window allows access to the advanced weld settings described below. These values
will normally reflect the default settings made in the Configuration Settings screen on the
Settings tab. Values set on this window will only affect the current preset’s settings.

Parameters:

¢ After Burst (s): Used to fire sonics for a predetermined amount of time after the weld is
complete and after After burst delay times out

o After Burst Delay (s): Used to delay after burst. Delay should be set so that no force is on the
part

* Hold time (s): Delays the release of the weld. Used to remove discoloration from the weld

e Squeeze Time (s): Delay the weld for a predetermined amount of time. Allows the force of the
cylinder to build up on the part before welding

e Pre Burst (s): Used to fire sonics for a predetermined amount of time after the Squeeze Time
and before capturing the Pre-Height. Used when welding magnet wire. It helps to break up the
insulation around the copper, and provide a small cooling period before the weld takes place

Weld Modes:

o Energy: Ultrasonics are activated until the specified amount of Energy (Watts integrate over
time) has been applied

e Time: Ultrasonics fire for a predetermined amount of time
e Height: Ultrasonic energy is applied until a predetermined height is reached

e Energy/Height Compensation: Used for contaminated parts. The controller will first put in the
predetermined amount of Energy, it will then look at the final height window. If the final height is
not within the window, the controller will then put in up to 3 times more energy to get to the
center of the window. Note quality window for time may need to be adjusted when using this
mode. Ultraweld L20 will shut down when the upper time limit is exceeded

e Amplitude stepping: There are three stepping modes available: Step - Energy, Step - Time,
and Step - Power. If a stepping mode is selected, you must also set the start amplitude, end
amplitude, and a step point. After choosing a stepping mode, set the start amplitude, end
amplitude and step point by editing the Amplitude setting located in the Weld Settings area of the
Setup screen. See Section 2.5.9 Amplitude Stepping for more information
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Off-set:

o Height Off-set: Displays the height measurement for the last weld. Touching the button under
the Measured column allows the user to enter the height he measured on the last welded piece.
The controller automatically adds a corrective offset to its measurements, so displayed values to
match the user’s measurements

Teach Mode Setting:

o Global: Select Global to use the Teach Mode settings set on the Teach tab on the configuration
screen. For more information, see Section 5.11.1.3 Teach Mode Settings

e Special: Select Special to enter different Teach Mode settings for the current preset

Setup Screen (When Running a Sequence)

Figure 5.17 Setup screen (When running a Sequence)
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This screen can be used to monitor actual weld and quality results for each weld.

You can choose this screen to be the start screen when you turn on your controller. For
information see Section 5.11.1.5 System Configuration.

NOTICE

While on the Setup Screen, no changes can be made to the preset
settings.

Displayed on the upper section of the screen are the sequence’s hame, the current step’s
Preset name, the part counter (Part Count), cycle counter (Cycles), the step’s batch size
(End Count) and the current step number. The cycle counter keeps track of the total
amount of welds performed while the part counter keeps track of the welds performed for
the current step. Touch the Cycles button to reset the cycle counter. There are two red
arrows on the upper right side of the screen. Touching the arrow pointing to the left will

DCM00060 REV. 13 61



BRANSON

5.10.5

take you to the previous step on the sequence. Touching the arrow pointing to the right
will take you to the next step on the sequence.

In the middle of the screen on the left side are the Weld Settings Box, the Advanced
Settings button, and the Quality Settings box. On the right side of each quality parameter
a circle is displayed. The parameters shown are the same as the ones described in
sections 5.10.3.1 Weld Settings, 5.10.3.2 Quality Settings, and 5.10.3.3 Advanced
Settings Screen, but they cannot be modified within the sequence. The circle will light
green for successful welds and red for unsuccessful welds. The controller will also display
a pop up window with an alarm message for unsuccessful welds.

Figure 5.18 Result is smaller than minimum height

Eﬂ Alarms

Teach Mode Screen

In the Teach Mode screen, the controller automatically derives the quality window’s limits
based on calculations performed on results from a weld sample set. It is operational in
three run screens: Setup Screen, Operator Screen and Statistical Analysis Screen. There
are three available teach modes: Standard Teach Mode, Auto Teach Mode, and Sigma
Teach Mode. To run Teach Mode click on: Run > Teach Mode Screen. The controller will run
in the teach mode currently selected in the TEACH tab in the Configuration Settings

window. See Section 5.11.1.3 Teach Mode Settings.

NOTICE

While in any of the Teach Modes, the screen background is orange
and the Quality settings are not editable.

NOTICE

Exit the Teach Mode by closing the application, loading a Preset/
Sequence, Saving/Editing a Preset/Sequence, or by switching to
following screens: Run New Preset/Sequence, File Manager,
Maintenance, Configuration Settings, and Administrator.
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NOTICE

You can switch between the Operator Screen, Statistical Analysis
screen, Weld Graph screen, Weld History screen and Error Log screen
without affecting the Teach process. While in teach mode, the
Operator Screen and Statistical Analysis screen will also be shown in
orange background.

NOTICE

To start a new Teach process click [Run -> Teach Mode Screen] and
select the required preset to be loaded from the list.

NOTICE

If you change any Weld/Advanced settings at any time, the Teach
mode restarts with wide open quality windows. The preset will be
saved at this point.

Standard Teach Mode

In the Standard Teach Mode the default quality windows (wide open) are used, and you
may accept or reject each weld as part of the sample set. Upon successful completion of
the sample set, the average values for Time, Power, Pre-Height, and Height are computed;
the allowable min/max deviation percentages are factored in; and the resultant is used to
calculate the weld settings and the quality window settings. The quantity of samples to be
run and the allowable deviation percentages for each weld parameter are set in the TEACH
tab in the Options > Configuration window. See Sections 5.11.1.3 Teach Mode Settings.
After completing the Teach process, the Preset and the quality windows settings are
saved; the gray Operator Screen is displayed; and you will no longer be in Teach Mode.

Auto Teach Mode

In the Auto Teach Mode you may not reject samples. If no changes are made to the Weld/
Advanced settings, the previously saved quality windows are used for the first five welds,
which form a basis. Their averaged values for Time, Power, Pre-Height and Height, plus or
minus ten percent tolerance, are used to evaluate the acceptability of the remaining
samples. If one of the remaining samples falls outside of this range, it is rejected and an
alarm occurs. Up to three welds may be rejected in a teach session. If a fourth bad weld is
encountered the Auto Teach process starts over with wide open quality windows. The run
quantity for Auto Teach Mode can be set in the Teach tab in the Configuration settings
window. When the Teach process is complete, the Preset and the quality window settings
are saved; the gray Operator Screen is displayed; and the system will be in monitoring
mode. While in monitoring mode you can weld normally. The system will restart a
complete Auto Teach session automatically if you change any of the weld parameters,
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quality windows settings, recall a new preset, or go to the File Manager, Maintenance,
Configuration or Administration screens.

NOTICE

In Auto Teach mode File > Create New Sequence, File > Edit
Sequence, Run > New Preset, and Run > New Sequence menu
options are always grayed out.

NOTICE

If you go to the Statistical Analysis or the Operator Screen just after
selecting Auto Teach option in Configuration screen, the application
will go directly into monitoring mode and you will be allowed to weld
normally with the currently loaded preset.

NOTICE

If Auto Teach mode is left selected in the configuration screen before
powering down, the system will display the operator screen; load the
previously loaded preset or default preset; and go directly in to
monitoring mode in Auto Teach mode on the next power up.

NOTICE

After Creating a New preset while in Auto Teach mode both Run >
Operator Screen and Run > New Sequence menu options are grayed
out. The only way to weld is to first go through the Auto Teach
process for the newly created preset by clicking Run > Teach Mode
Screen.

5.10.5.3 Sigma Teach Mode

The Sigma Teach mode collects data for the last 128 samples taken for each weld. It limits
itself to the last 128 samples to keep data and statistics that will be meaningful to the
current sample. The Sigma Teach mode calculates the average and standard deviation for
each or the monitored parameters (Time, Power, Preheight, and Height). The early
samples are displayed starting on the left of the screen and, as they are added, continue
from the left to right.

At 128 and later samples, the oldest data point on the left is removed and the latest data
point is added at the right position. Average and standard deviation are always based on
the latest data. Removed data has no influence on the calculations.

Standard deviation is calculated with an (n-1) weighting. This tends to make the smaller
values of the n have wider standard deviations.
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The collected data is displayed between the Upper Specification Limit (USL) and the Lower
Specification Limit (LSL). These are the limits as shown on the Run screen. If there are
more the 3 samples in the data a Gaussian curve is displayed. The Gaussian curve is
positioned between the limits and as much of its data as possible is displayed. There are
markers on the curve to show 1, 2, 3, 4, 5, standard deviations. The 1, 2, and 3 markers
are vertical while the 4 and 5 are horizontal (see Figure 5.19 Sigma markers below). The
most desirable situation is narrow limits with a tight curve.

Figure 5.19 Sigma markers

—<: 5
—G4
—

KO3 K332

—@5
e (] 4

After completing the Teach process, the Preset and the quality windows settings are
saved; the gray Operator Screen is displayed; and you will no longer be in Teach Mode.
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5.11 Options Menu

The Options pull down menu contains the following choices:

5.11.1 Configuration

User is allowed to configure the following features of the application.

e Actuator

e Default Setup

e Teach

e System Configuration
e Com Settings

5.11.1.1 Actuator

The Actuator tab found in the Configuration screen allows you to setup the VersaGraphix
to work with your Actuator model.

Figure 5.20 Actuator Tab

1G] Configuration Settings 3

File Run Options View Help
BRANSON
Actuator |Default Setup | Teach | System Configuration | Com Settings
Select Actuator
« UltraWeld L 20 20328
. MWX100  Ultrasplice XL
~ UltraSeal 20 “ Auto Terminator

" Ultrasplice 40

Options

- 15|

-
-
I” Double Hit Mode

r I~ Quick After-Burst

The VersaGraphix can be setup to work with any of the following actuators:

e UltraWeld L20

e« MWX100

e Ultraseal 20

e Ultrasplice 40

e Ultrasplice XL

e Auto Terminator

On this tab you may also set the following:

e Double Hit Mode: Used for Automation. Do not activate unless instructed by Branson

e Quick After Burst: The after burst function is implemented immediately after each weld cycle
finished without any time delay or condition judgment
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5.11.1.2 Default Preset Settings

Figure 5.21 Default Setup Tab

1| Configuration Settings
File Run Options View Help

Actuator DEFAULT SETUP |Teach

System Configuration | Com Settings

These settings are used by the build program to initialize WELDER SETTINGS.
Changes will only affect NEW parts. Any parts built prior to the changes will remain as is.
Individual parts that are changed in the set-up modes are not affected by any change here.

AB Delay 0.00s Welding Mode
= Energy  © Time ~ Height " Energyl/Height
AB Duration w
Trigger Pressure
L w # Use Weld Pressure
Hold Time w " Use Pressure PSI

Pre.Burst 0.00s DEFAULTS |

Set the default weld settings for all new presets on the Default Setup tab. These settings
will only affect new presets. You may set the following parameters:

e AB Delay

e AB Duration

e Squeeze Time

e Hold Time

e Pre-Burst

e Welding Mode

e Trigger Pressure

See Sections 5.10.3.1 Weld Settings and 5.10.3.3 Advanced Settings Screen for more
information on these parameters.
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5.11.1.3

5.11.1.4

Teach Mode Settings

Figure 5.22 Teach Tab

m Configuration Settings

File Run Options View Help
BRANSON
Actuator | Default Setup %TEACHIISystem Configuration | Com Settings
I

Time Power Pre-Height Height Time Power Pre-Height Height
* 40% 25% 15% 10% 4 4 4 4

40% 25% 15% 10% 4 4 4 4

Teach Mode
@ Standard  Auto ¢ Sigma
Ea
I~ Check For Quality Limits
Run Quantity

On the Teach tab you may select the teach mode the VersaGraphix will use. There are
three different teach modes available: Standard, Auto, and Sigma. On this tab you can set
the run quantity and allowable deviation percentages for the Standard or Auto teach
modes. See Section 5.10.5 Teach Mode Screen for more information on Teach modes.

Check for quality limits

Add the “check for quality limits” check box in the teach tab of the configuration menu to
enable/disable (turn ON/OFF) the “Check for Quality Limits” mode. When in the “Check for
Quality Limits” mode, if the recalled preset has never been through the teach mode yet,
then the preset will be automatically recalled into the teach mode menu; else the system
will work as usual and go to Run mode with the recalled preset. If the check box is
disabled, the system will also work as usual. In this scenario, all the splices/presets of
sequence need to be checked in the sequence mode when a new sequence is recalled. An
error message will be shown up on the screen as long as there is anyone unqualified
splice/preset in the recalled sequence. Error Message says the following: “Teach Mode
Required” then shows the unqualified splice/preset.
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5.11.1.5 System Configuration

Figure 5.23 System Configuration Tab

L{4 Configuration Settings

File Run Options View Help
4|
Actuator | Default Setup | Teach SYSTEM CONFIGURATION |Com Settings
Sequence Error
¥ Height Encoder =
¥ Seek Restart
¥ Foot Pedal Abort £Continve
I~ Auto Get Next -Double Click
¢ Restart
I~ Lock On Alarm © Next
I~ Cooling © Not Allowed
¥ Cooling(1secl100J)
-Startup Screen
I~ Enable Graph Screen © Operator Run Screen
I~ Keep Daily History ¢ Setup Run Screen
I~ Graph Data

C 1ms ¢ Sms € 10ms -PRESSURE -

" Remote Data Logging & To PSI
I” Graph Data C To Bar
I~ ANVIL Retract Function € To kPa (Kilopascal)
Cooling Duration 1.00s Cooling Delay 0.00s

Height Encoder: Toggles the height encoder on/off.

Seek: Toggles Seek function on/off. This pulses ultrasonic energy to the stack prior to
each weld in order to allow the system to tune to stack frequency.

Foot Pedal Abort: When this box is checked, foot pedal must be maintained until sonic
starts or the weld cycle will be aborted.

Auto Get Next: When this box is checked the Ultraweld L20 automatically sequence to
the next part. Used in sequencing.

Lock On Alarm: Toggles between locking or allowing a weld to continue when an alarm
condition exists. When set to lock the actuator will not release the part until a password is
entered.

Cooling: Enables the setting of a predetermined amount of time the cooling air will stay
on after a weld.

Cooling (1sec/1003): Automatically sets cooling duration after a weld to 1 second per
100] of energy applied.

Enable Graph Screen: Enable Disable Power Graph data.

Keep Daily History: When this box is checked the Ultraweld L20 will create a daily folder
on the hard drive to store all weld results. If the Graph Data box is checked the Ultraweld
L20 will also store the weld power readings, sampled every 1ms, 5ms or 10ms (depending
on the option that is selected) into a text file.

Remote Data Logging: When this box is checked the Ultraweld L20 will send weld
results out the Ethernet port at the end of each weld cycle. If the Graph Data box is
checked the Ultraweld L20 will also send the weld power readings, sampled every 1ms,
5ms or 10ms (depending on the option that is selected).
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Sequence Error: Sets what the Ultraweld L20 should do when a weld error occurs when
running a sequence. It has two Options:

e Restart - to restart the sequence from step 1
e Continue - To reweld the same step in the sequence

Double Click: Sets double click action when running a sequence. The options are:

e Restart the sequence - to restart the sequence from step 1

e Next - to move to the next step of the weld sequence

e Not allowed - to disable double click inputs

Startup Screen: Sets the screen that will be displayed on powerup. The options are:
e Operator Run Screen

e Setup Run Screen

Cooling Duration: To change the amount of time the cooling air is on after each weld
cycle.

Cooling Delay: To change the delay period after a weld and before cooling is turned on.
Pressure: Toggles pressure units between the 3 options available:

e To PSI
e To Bar
e T kPa (Kilopascal)

5.11.1.6 COM Settings
Figure 5.24 COM Settings Tab
File Run Options View Help
BRANSON
Actuator | Default Setup | Teach [ System Configuration COM SETI'INGS}
RS232 Ports
Branson Controller Remote Preset Shrink Tube
COM2(Default) - Disabled - Disabled -
Server port 0
View IP Configuration ‘
+— | Esc ‘
On the COM SETTINGS tab you can configure serial port and Ethernet settings to
communicate to its internal controller and an external devices.
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Branson Ultraweld L20
The Branson Ultraweld L20 is connected to port COM2 by default.
Remote Preset

Presets and sequences can be recalled by an external user application connected to one of
the available RS-232 serial ports. Use this drop-down selection list to set the serial port to
which the application will be connected. The ports available for Remote Preset recall are
COM1, through COM4. Baud rate is fixed at 115000 baud.

To recall a Sequence or Preset, a string containing the ‘Preset Name’ or a ‘Sequence
Name’ followed by a carriage return must be sent by the user application:

NAME<CR>

NOTICE

The application will search sequences first, then search presets.

Sequence or Preset to the VersaGraphix application.

The VersaGraphix application returns one of three responses:
SsNAME<CR><LF> Application found sequence.
PNAME<CR><LF> Application found preset.

NNAME<CR><LF> Application found neither a sequence or a preset or it found a
sequence with a missing preset.

The VersaGraphix application will timeout after 5 seconds if characters are sent without a
carriage return <CR>. A response “Timeout” will be sent and the receive buffer will be
reset.

Shrink tube

The VersaGraphix Ultraweld L20 can be connected to an external Raychem® RBK-
ILSProcessor shrink tube machine. Use this drop-down selection list to set the serial port
to which the shrink tube machine will be connected.
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View IP Configuration

Displays the current IP configuration.

Figure 5.25 View IP Configuration

BRANSON

IP address 125.115.10.104
Subnet Mask 255.255.255.0

Default Gateway 165.116.16.1

NOTICE

The Host IP Address must be set from the Microsoft XP Control panel.

Server Port

Sets the server port that will be used to communicate between the VersaGraphix and user
data logging application.
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5.12 Remote Data Collection

At the end of each weld cycle the VersaGraphix writes a line to the daily history log file if
“Keep Daily History” is enabled.

This special will echo this line to a remote user application through an Ethernet socket
connection. For this special the data format will be hard coded.

A header will be sent every time the user connects to the socket.

5.12.1 Connection to VersaGraphix SBC will be through a TCP/IP socket

NOTICE

The Unified Write Filter (UWF) must be disabled when configuring the
SBC's Network Connections.

The 'Host IP Address' will be set outside the application at the system level.

e Exit the VGX application
e Disable the UWF

UWF Configuration Utility

The UWF Configuration Utility is a command-line tool designed to manage the Unified
Write Filter (UWF) on Windows systems. It allows users to enable or disable disk
protection, add or remove files/folders from the exemption list, and manage UWF settings.

Prerequisites

e Administrative privileges are required to run this utility.

Running the Utility

1. Navigate to the directory containing the "UWF Configuration Utility.cmd” file:
C:\UWF Configuration Utility\

2. Right-click on the "UWF Configuration Utility.cmd” file.

Select “Run as administrator” from the context menu.
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Main Menu
Figure 5.26 Main Menu

BN Select C:\Windows\System32\cmd.exe

L B ek

o

Upon running the script, the main menu will be displayed with the following options:

Enable Disk Protection

Disable Disk Protection

Add a File/Folder to the Exemption List
Remove a File/Folder from the Exemption List
Exit

i B whE

Menu Options

1. Enable Disk Protection

e Protects the C: drive with UWF.

e Changes will take effect after a system restart.

e The system will automatically restart after enabling protection.

2. Disable Disk Protection

e Removes protection from the C: drive.

e Changes will take effect after a system restart.

e The system will automatically restart after disabling protection.

3. Add a File/Folder to the Exemption List

e Prompts for the path of the file/folder to be added to the exemption list.

e Ensures the specified path exists before adding it to the exemption list.

e Changes will take effect after a system restart.

4. Remove a File/Folder from the Exemption List

e Prompts for the path of the file/folder to be removed from the exemption list.
e Ensures the specified path exists before removing it from the exemption list.
e Changes will take effect after a system restart.

5. Exit

e Exits the utility.

74 DCMO00060 REV.



BRANSON

Error Handling

o If UWF is already enabled, the utility will notify the user and proceed to the main menu.
e If an error occurs while enabling UWF, the utility will notify the user and exit.

e If an invalid option is selected from the menu, the utility will prompt the user to enter a valid
option.

Notes

Ensure all paths entered for adding or removing exemptions are correct and exist on the system.

e The system will restart automatically to apply changes when enabling or disabling disk
protection.

e Allow the unit to reboot
e Exit the VGX application
e Set the 'Host IP Address' in Windows

¥ Ethernet 2 Properties

Networking ~ Authentication Sharing ternet Protocol Version 4 (TCP/IPv4) Prope

Connect using:
P Intel(R) Ethemet Connection (22) 1213-LM

General

You can get IP settings assigned automatically if your network supports

this capability. Otherwise, you need to ask your network administrator
Configure... for the appropriate IP settings.
This connection uses the following items:

) &3 Client for Microsoft Networks A (O Obtain an IP address automatically

™ % File and Printer Sharing for Microsoft Networks (@) Use the following IP address:

™ QoS Packet Scheduler

I sdves:

™ s Intemet Protocol Version 4 (TCP/IPv4) -

[ 4 Microsoft Network Adapter Muttiplexor Protocol Subnet mask: 255.255.255. 0 |
e i oeas s e
Ml 4 Intemet Protocol Version 6 (TCP/IPv6) v gateway:
< >

Obtain DNS server address automatically
Install Uninstal Properties (@ Use the following DNS server addresses:

Description Preferred DNS server: . . . ‘
Transmission Control Protocol/Intemet Protocol. The default

wide area network protocol that provides communication Alternate DNS server: [:
across diverse interconnected networks.

[[Jvalidate settings upon exit P
oK Cancel = Gl
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e Open the VGX application
Set the 'Server Port Number' to 4200.

[ configuration Settings X
File Run Options View Help

Actuator | Default Setup | Teach | System Configuration Com Settings
RS232 Ports
Branson Controller Remote Preset Shrink Tube
COM2(Default) - Disabled - Disabled -

View IP Configuration ‘

e Options/Configuration/COM SETTINGS/Server Port'. Default= 4200

5.12.2 Testing Remote Data Collection
e Testing and verification will be done using TeraTerm.
e Connect to the VersaGraphix SBC using an Ethernet Cable.
e Start TeraTerm Terminal on the remote PC.
e Connect Using: TCP/IP
e Host Address: (Use IP address of VersaGraphix SBC)

Eﬁ View IP Configuration |z‘

BRANSON

IP address  192.168.10.100
Subnet Mask 266.266.266.0

Default Gateway 192.168.10.1

e Port Number: 4200 (default)
e Make a Weld Cycle
e Weld results should be displayed as follows:

| 1921681
ile Edit Setup Control Window Help

Quality Windos ime+ ime- ouer- oue: eHeight+ PreHeight— Height+ Height— Weld |
S1/29/2 * "D ° - 8.00 3960 N 3.76 14.78  14.76 -
129,209 1 an - E o.00 3960 - - 3.% 1476 14.7%
129,209 11:02:00 AN - E o.00 3960 - - 3.% 1476 14.7%
129,209 02 - E o.00 3960 - - 3.7 1476 14.7%
129,209 - E o.00 3960 - - a7 1476 14.7%
129,209 11:02:27 AN - E o.00 3960 - - 3.7 1476 14.7%

1/29/2019 11:02:37 an X . 0.0 3968 X X 3.77 14.7%  14.76
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5.13 View Menu

The pull down View menu contains the following choices:

5.13.1 Weld Graph

Figure 5.27 Weld Graph

[E wWeld Graph,

Fower ¢ initat )

0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000
Time ( in MiliSecond )

Print

Touch View > Weld Graph to display a pop up window containing a graph of Power (Watts
vs. Time) for the last weld performed.

Weld graphs are sometimes referred to as weld "foot print". It can be used to visualize the
weld cycle and assists in parameter optimization. Graphs from consecutive welds will vary
slightly as the system dynamically adjusts time to accommodate varying surface
conditions. (See Figure 2.2 Weld Power Graph for Clean Components, Dirty Components,
and when Part is Missing).

NOTICE

Weld Graph data can be saved into a text file or sent out the Ethernet
port. See 5.11.1.5 System Configuration for more information.
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5.13.2 Statistical Analysis Screen

Figure 5.28 Statistical Analysis Screen

[ﬂ‘] Statistical Analysis v

File Run Options View Help
BRANSON

USL :0.72s M
Time M

LSL :054s
USL : 423W

Power /‘l m

+

;

LSL : 300W

USL : 2.89mm
e
+
Pre-Height NMM
LSL : 2.68mm
USL : 2.56mm W &
Height U/l)\ﬂv/ \|
LSL : 2.36mm
Print
Part Name: 10AWG Area: 5.00mm~*2 Parts Count: 32 Weld Mode: Energy

The Statistical Analysis screen displays a histogram and Gauss curves for an accumulation
of up to 128 samples of the current part.

The program keeps a file on each part and records each sample as it is run. The file is
updated at the end of each weld cycle that does not contain any faults. Weld cycles that
contain faults are not included in the data nor is the parts counter increments. The file
contains data for the last 128 weld cycles for the current part. If less than 128 cycles are
available, only those available are displayed. If more than 128 parts are on the counter,
the file is updated by discarding the oldest sample data and adding the latest sample data.
The average, standard deviation, and Gauss curves are based on the latest data.

The labels USL and LSL are the upper and lower Specification Limits set on the Setup
Screen. The Gauss curves are displayed proportional to the upper and lower specification
limits and have markers for the 1, 2, 3, 4, 5 and 6 sigma deviations if they fall inside the
limits. No Gauss curves are displayed if the parts counter is less than 3.
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5.13.3 Error Log

Figure 5.29 Error Log

ﬁ:f] Error Log,
File Run Ontions View Heln
BRANSON
Date/Tims | Part Name | Errar [ Walue |
0G-0ct08 34444 PM 106G Height 2.43mm
09-0ct08 34435 PM 108G Height Z4Tmm
08-0ct08 31816 PM 10E8WGE Powser 227
08-0ct08 310:12 PM 10EWE Pre-Height 2. 60rarn
06-0ct08 310:10 PM 108G Pre-Height 262mm
08-0ct-08 303:00 PM 10E8WG Height 2. 35mm
A 108G Fre-Height 2.56mm

Print Data

The Error log keeps track of all unsuccessful welds and their fault cause. You can generate
a printout of all errors by touching the Print Data button.

5.13.4 Weld History

Figure 5.30 Weld History

File Run Options View Help
BRANSON

Entry Time Power Pre-Height Height

E 0625 3m2w 247 mm 2,80 mm
E] 061s 368w 249 mm 2.80 ram
10 053s 384w 24d mm 274 mm
1 0B2s 368w 244 mm 281 mm
12 0B3s 352w 248 mm 2.76 mm
13 OBds 352w 249 mm 2.80 ram
14 OB4s 362w 248 mm 280 mm
15 071s 320w 2.54 mm 2.84 mm
16 0B6&s 336w 253 mm 2.80 ram
17 0E1s 368w 260 mm 2.82 mm
18 072s 320w 253 mm 2,80 mm
19 061s 368w 244 mm 274 mm
20 OFGs 362w 248 mm 280 mm
21 0B6s 352w 248 mm 2.78 mm
22 067 s 320w 251 mm 282 mm
23 0B4s 362w 247 mm 278 mm
24 067 s 336w 251 mm 2.78 mm
25 0OBds 352w 248 mm 2776 mm
26 OFGs 336w 260 mm 2.82 mm
27 0B1s 368w 243 mm 2.75 mm
28 OBds 352w 250 mm 2.80 ram
23 0B6s 352w 241 mm 275 mam
an 0B4s 362w 248 mm 278 mm
3 0BSs 33w 2.54 mm 2,82 mm
32 062s 368w 247 mm 278 mm
a3 0B7s 336w 248 mm 2.82 mm
34 0645 352w 248 mm 2,80 mm
35 OBds 352w 247 mm 2.80 ram
36 0Bds 336w 261 mm 284 mm
i 0645 352w 246 mm 2.76 mm
38 063s 368w 249 mm 282 mm
et OFGs 362w 242 mm 273 mm
40 071s 320w 253 mm 2,80 mm
41 0B5s 352w 247 mm 2.80 ram

Print Data

On the Weld History screen you can view all saved weld results. You can generate a
printout of all weld results by touching the Print Data button.
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NOTICE

The Keep Daily History checkbox on the Settings tab on the
Configuration screen must be checked for the controller to store weld
results.

NOTICE

Weld results can also be sent out the Ethernet port at the end of each
weld cycle. See Section 5.11.1.5 System Configuration for more
information.
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5.14 Help Menu

In the Help pull down menu you can select About VersaGraphix to view the VersaGraphix
software version and Ultraweld L20 version.

Figure 5.31 About VersaGraphix

VG About Versagraphix

BRANSON

VersaGraphix Metal Welding Software
Branson Ultrasonics Corporation
Software Version: 25.73.820
Controller Version: V10.02.007
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5.15 Language Support

Figure 5.32 Language Settings

[ Language Settings

. English | Portugués Tiirkge
Frangais Espafiol Italiano
Deutsch Magyar fEitEd 3

HZE =0l EEvx

Pycckuia polski Thai
Romanian Czech Republic | Slovenlina
— Esc [

The VersaGraphix software supports 18 user selectable languages. The supported
languages are: English, French, German, Japanese, Russian, Romanian, Portuguese,

Spanish, Hungarian, Korean, Polish, Czech, Turkish, Italian, Simplified Chinese, Traditional
Chinese, Thai and Slovenian.,

NOTICE

Touch the Branson logo on any of the screens to pop up the Language
Settings window.
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Chapter 6: Maintenance
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6.1

6.1.1

6.1.2

Preventive Maintenance

WARNING

e Use LOTO (Lock Out Tag Out) lockable plug cover over line cord plug
during any maintenance

e All system components must be disconnected from the main electrical
supply

¢ All system components must be disconnected from the main air supply
and system air pressure must be released via the pressure regulator

e When performing maintenance on the welder, make sure that no other
automated systems are active

The following preventive measures help assure long term operation of your Branson
equipment.

Periodically Clean the Equipment

Air is continuously drawn into the Branson VersaGraphix Ultraweld L20. Periodically
disconnect the unit from power, remove the cover and vacuum out any accumulated dust
and debris. Remove material adhering to the fan blades and motor, transistors, heat sinks,
transformers, circuit boards, cooling intake vents, and exhaust ports. Filters can be added
to the VersaGraphix cooling fans for dusty environments. External covers may be cleaned
with a damp sponge or cloth using a solution of mild soap and water. Do not allow cleaning
solution to enter the unit. To prevent rust in areas of high humidity, exposed steel
surfaces, such as handles, hardware, and the main column may require a very light film of

oil, such as WD-40®1,

NOTICE

When it is necessary to clean the touch screen, wipe gently with a
soft cloth dampened with a mild window glass commercial cleaner or
50/50 mixture of water and isopropyl alcohol. Use a soft cloth
moistened with mild detergent to clean the display housing. Do not
use abrasive cleaners, waxes or solvents to clean the touch screen
monitor.

Routine Component Replacement

The lifetime of certain parts is based on the number of cycles the unit has completed, or
on hours of operation, e.g., at 20,000 hours, cooling fans should be replaced.

1. WD-40 is a registered trademark of WD-40 Manufacturing Company Corporation.
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6.2 Parts List

This section provides the list of replacement parts.

Figure 6.1 VersaGraphix Ultraweld L20

IOutput Module" Line FiIter" DC Power Supply

i -

[

Monitor Cable

P —

18]

U

T

USB Cables (Back),
Monitor Cable

USB Cables
(Front)

Machine Controller | Ethernet |

Board on Top

Control Board Underneathl

Table 6.1  Suggested Spares

Description Part Number
Control Board' 102-242-1272R
Machine Controller Board 102-242-968
DC Power Supply 200-132-294R
Line Filter 100-242-1199R (100-242-1230R for 4KW units only)
Output Module? Call Branson
Fan 100-126-015R
Line Cord 100-246-947
Touchscreen monitor BU-1039160
Monitor Cable BU-1039334
Computer Call Branson
Ethernet Call Branson
USB Cables (Front) BU-1039342
USB Cables (Back) BU-1039343

1Please go to “About Branson” on the Help dropdown menu for software version and controller version.
Have power supply wattage and frequency available for costumer service.
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6.3 Parts Replacement

CAUTION

The Branson VersaGraphix Ultraweld L20 contains components that
can be degraded or damaged by electrostatic discharge. Always use a

Grounded Wriststrap and use a grounded work area when handling or
servicing the VersaGraphix.

The VersaGraphix is designed for a long service life. In the event the system malfunctions,
many of the internal components (Modules) are replaceable as a unit. If a particular
module has failed, it should be replaced or repaired at an Branson Depot Facility.
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6.4.1

BRANSON

Troubleshooting

When the Branson VersaGraphix Ultraweld L20 encounters a situation that is outside
normal conditions, an alarm is generated. If there is any alarm condition, the Touchscreen
displays an alarm message and generates an audible alarm (see Table 6.2 System Alarms
with Probable Cause and Corrective Action). If you use the Emergency Stop button to
terminate a weld, the welder will not operate until reset.

System Alarms

The following table details alarms that you can encounter on the VersaGraphix, listed
alphabetically by the Display Message that is presented on the touchscreen. The message
on the touchscreen of VersaGraphix is shown in the first column. The second and third
columns indicate the condition that led to the alarm and the corrective action you should

take.
Table 6.2
Alarm Message

COM port Error

Cause

System Alarms with Probable Cause and Corrective Action

Corrective Action

EMERGENCY STOP ON!

Emergency stop is active

Unlock emergency stop button

FILE ERROR

Height System failure

Ultraweld L20 did not see
the encoder move 1mm in
1 second

Check air pressure. Check
flow controls.

Highest power is above
power maximum

Power result above the
maximum quality window

Highest power is below
power minimum

Power result below the
minimum quality window

Invalid PASSWORD Re-
enter data

Wrong password entered

Enter correct password

Lock On Alarm

Quality windows exceeded.

Part is locked down

Enter password to release
part.

Password Exists!

Enter different password

Power OVERLOAD

Power results above the
maximum available power

Result is smaller than
minimum height

Final height is below
quality window

Result is taller than
maximum height

Final height is above
quality window

Safety System Abort!

Safety system

Weld longer than
maximum time

Weld cycle too long

Check for parts
contamination. Make sure
correct preset is used. Check
tooling for wear.
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Table 6.2 System Alarms with Probable Cause and Corrective Action

Alarm Message Cause Corrective Action

Check proper preset is used.
Check air pressure. Check
correct parts are being
welded.

Weld shorter than

minimum time Weld cycle too quick

Memory has reaches 90% Transfer the History files to an

Insufficient Storage of Capacity external drive.

6.4.2 Safety Circuit Alarms

The Safety Control System within the Controller constantly monitors the system's safety
related components for correct operation. When this system detects a fault condition,
operation is interrupted and the system immediately goes to a safe state. A beeper is used
to signal a safety system alarm.

Use the following procedure to troubleshoot safety circuit alarms:

1. Verify that the 9-pin footswitch cable is properly connected to the back of the Controller.
2. Power down and then power up the Controller to reset the system.
3. If the alarm persists, call Branson Support. See 1.5.3 Contact Information
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Service Events

WARNING

Service events should be performed only by qualified individuals. The
potential for injury or death exists, as well as that for damage to the
equipment (which can include loss of product warranty) or loss of
valuable setup information for your application.

When servicing the system, the service person(s) can have a need for
certain conventional hand tools, and you might need to have the
following information for testing or returning the system to service.

Required Tools

Special tools for the ultrasonic Converter, such as spanner wrenches, are provided with
your system. You might also need the following hand tools or service tools:
e Six-inch or longer Phillips-head screwdriver with a magnetic tip or screw starter

e Good-quality multi-meter for continuity, AC and DC voltages, and resistance, with insulated test
probes

Cold Start Procedure

The VersaGraphix’s internal memory stores the system default settings and the
parameters that you set. It also provides temporary storage to support the Ultraweld L20’s
internal functions. A Cold Start clears Battery Backed RAM (BBR) values and restores
them to their original factory defaults. It is not necessary to perform a cold start during
normal operation and servicing, but you might find a cold start helpful when:

e You suspect the system is not operating properly
e You want to reset the system to its factory default setup

Performing a Cold Start

NOTICE

Before performing a cold start, the power supply power rating and
maximum amplitude should be written down. This information will be
needed for input after clearing the BBR. It can be found in the
Maintenance Screen under Test Sonics.

To perform a Cold Start touch the Init BBR button on the Options tab in the Administrator
screen (see 6.5.4.1 Administrator Options Tab). Once a cold start is performed the Height
needs to be recalibrated, along with reinstating the calibrated amplitude and power rating.
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6.5.3 Maintenance Screen

Figure 6.2 Maintenance Screen

File Run Options View Help
BRANSON

UltraWeld L20

Q Horn Maintenance Counters |

O Cooling | Calibrate Height | Maintenance Limits |

O AUX1 | Test Sonics | Maintenance Log |

@ AUX2
O AUX3
O AUX4

/0 Board

Clamp Off Gather Closed
Horn Closed Cooling Air
Machine Ready Signal Signal Light
Advanced Start Seek l l Sonics On
QUTPUTS

Palm Button 1 INO
Emergency Stop Switch Safety Slide
IN2 Air Pressure Monitor

INPUTS T T
Palm Button 2 Operator Signal Button

The maintenance screen allows the adjustment and on-demand control of
electromechanical devices in your actuator. This screen also allows you to clear
maintenance counters, set maintenance limits and make entries to the maintenance log.

The left hand set of buttons have indicators associated with them. Touching each of these
buttons allows you to:

Horn: Toggle the horn between the up and down positions.
Cooling: Toggle the cooling air control solenoid on and off.

Aux 1-Aux 4: Toggle auxiliary actuators (used on special equipment). You may rename
the auxiliary buttons in order to describe their given function (see 6.5.4 Administrator for
more information on renaming auxiliary buttons).

The indicators under the I/O BOARD label show the current state of digital inputs and
outputs.
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6.5.3.1 Calibrate Height

Figure 6.3 Height Calibration

[m Height Calibration

To Calibrate the Height.

Position a 1.00 mm gauge,
Push CALIBRATE, or Type Maximum Gauge size
and Push CALIBRATE then.

Calibrated Height = 19.84

Down Speed = 0.00 mmisec

Voltage = 2422 mV

; HORN ]l CALIBRATE |

Maximum Gauge: 6.00mm |

Esc

This window is used to perform a height (from horn to anvil) calibration. The instructions
on screen explain the calibration procedure.

The following buttons are used to perform a height calibration:
Horn: To move the horn up and down against the anvil.
Calibrate: To calibrate the height.

Press the ESC button to return to the Maintenance Screen.

Maximum Gauge: To set up the second gauge. Default setting is 6mm. If entered a value
which is out of range, a alarm message will show up.
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6.5.3.2 Test Sonics

Figure 6.4 Test Sonics
BRANSON

Sonic Generator Test

O ‘ Run Sonics |

O Run Sonics100% |

O Reset |
Power Supply 3300W

Amplitude Value 150pm

Power
20 40 60 80 100 120
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This screen allows the on-demand control of ultrasonic weld energy and the calibration of
amplitude.

Amplitude calibration requires a dial indicator to be temporarily mounted in line with, and
in front of, the horn, usually on a magnetic base. The Run Sonics 100% is held and the
gage reading is viewed.

The gage reading x2 = total amplitude, this is the value to be entered as the amplitude
value when calibrating.

The following buttons are used to test the Power supply and to calibrate the amplitude:
Run Sonics: Used to fire ultrasonic energy at the current amplitude setting.

Run Sonics 100%: Used to fire ultrasonic energy at 100% amplitude. Used when
calibrating amplitude.

Power: Power rate is displayed in real-time.

Power supply button: This value is set by Branson for a given actuator and should not
be changed. Generally the setting for 20 kHz actuators is 3300W and the setting for
40 kHz actuators is 800W.

Amplitude Value Button: Used to set the amplitude value based on the gage reading.
See above.

Press the ESC button to return to the Maintenance Screen.
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Maintenance Counters

Figure 6.5 Maintenance Counters

BRANSON
TIP fox HORN 0
ANVIL oKkJ CONVERTER 0
TOOL 1 0KJ GENERATOR 0
TOOL 2 0KJ ACTUATOR 0
Esc

The lifetime of certain parts of your Branson system is based on the number of weld cycles
performed, or the energy delivered for welding. Other parts require periodic maintenance
depending on the number of cycles performed, or the energy delivered for welding.
Maintenance Counters allow you to easily keep track of your system’s maintenance
requirements.

Maintenance counters and Maintenance limits are related. They are used in conjunction to
schedule component maintenance or replacement. Maintenance counters increment after
each weld cycle up to the limits set by the user on the Maintenance Limits screen. When a
limit is exceeded the VersaGraphix will display warning on screen the next time it is turned
on. Any maintenance counter which value is less than its corresponding limit does not
produce an alarm. See 6.5.3.4 Maintenance Limits for more information on maintenance
limits.

The maintenance counter window allows you to reset the counters to zero. Touch the
name of the counter you want to reset (you will be prompted to confirm).

A maintenance counter should be reset after a maintenance is performed on the part it
relates to.

Press ESC to return to the maintenance screen.
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6.5.3.4

Maintenance Limits

Figure 6.6 Maintenance Limits

BRANSON
TIP 0KJ HORN 0
ANVIL 0KJ CONVERTER 0
TOOL 1 0KJ GENERATOR 0
ToOL 2 OKJ ACTUATOR 0
- | S

The lifetime of certain parts of your Branson system is based on the number of weld cycles
performed, or the energy delivered for welding. Other parts require periodic maintenance
depending on the number of cycles performed, or the energy delivered for welding.
Maintenance Counters allow you to easily keep track of your system’s maintenance
requirements.

Maintenance counters and Maintenance limits are related. They are used in conjunction to
schedule component maintenance or replacement. Maintenance counters increment after
each weld cycle up to the limits set by the user on the Maintenance Limits screen. When a
limit is exceeded the VersaGraphix will display warning on screen the next time it is turned
on. Any maintenance counter which value is less than its corresponding limit does not
produce an alarm. See Section 6.5.3.3 Maintenance Counters for more information on
maintenance counters.

The Maintenance Limits window allows you to set the maintenance limits for the listed
items. Touch the name of the counter limit you want to set and a numeric keypad will pop
up so you can set the counter limit. If a limit is set to 0 the controller will not yield an
alarm for the counter regardless of its maintenance count.

The left side counter limits for the Tip, Anvil, Tool 1 and Tool 2 are set in kilo-joule units.
For example, if the energy weld setting in use is 1500 joules, a limit setting of 7500 kilo
joules will produce about 5000 cycles before reaching its limit. The Tool 1 and Tool 2
counters may be used to represent any special fixture tooling.

The right side four values on the screen for horn, converter, generator (ultrasonic power
supply), and actuator are set in number of weld cycles.

Press the enter button to save the changes.

Press ESC to return to the maintenance screen without saving the changes.
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6.5.3.5 Maintenance Log

Figure 6.7 Maintenance Log

[f4 Maintenance Log X

D ated Tirne | Entry |
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04-Map-0341256:26 P VERIFYED MACHIME PRESETS - G.T. 1D 0115 Make Entry
Print Entries
Exit

The VersaGraphix has a built in Maintenance log that allows you to keep track of
maintenance or testing done to your system.

On the Maintenance Log pop up window you can make entries to the controller
maintenance log. Entries are limited to 100 characters per entry. You may also generate a
printout of all currently stored entries.

6.5.4 Administrator

On the Administrator screen you can perform a system Cold Start; exit the VersaGraphix
software; shut down the system; and manage password requirements and screen access
permissions.

NOTICE

The Administrator screen can only be accessed by entering the
Administrator Password. The default Administrator password is
ADMIN.
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6.5.4.1 Administrator Options Tab
Figure 6.8 Administrator Options Tab
Flle Run Ontlons View Help
BRANSON
OPTIONS T Permissions T Password List
" Shutdown Windows at EXIT
¥ Passwords are required
Init BBR ‘
Rename Aux Buttons ‘ Exit the System
On this Tab you have the following check boxes and buttons:
Shutdown Windows at EXIT: Set this checkbox if you want the system to shut down
when the Exit System button is pressed. If left unchecked the Software will give control to
windows when the Exit System button is pressed.
Passwords are required: Set this checkbox to make passwords required when
accessing the Maintenance, Setup, Configuration, Create Preset/Sequence, Edit Preset/
Sequence, and Teach Mode screens, as set on the Permissions tab. See 6.5.4.2
Administrator Permissions Tab.
Init BBR: Touch the init BBR button to perform a Cold start. Touching this button resets
the VersaGraphix’s BBR (Battery Backed Ram) to its initial factory defaults. See Section
6.5.2 Cold Start Procedure for more information on performing a Cold Start.
NOTICE
Before performing a cold start, the power supply power rating and
maximum amplitude should be written down. This information will be
needed for input after clearing the BBR. It can be found in the
Maintenance Screen under Test Sonics.
Rename Aux Buttons: Touching this button will cause the Rename Aux Buttons window
to pop up. On this Window you may rename the four Auxiliary buttons shown on the
maintenance screen. These buttons are used to control additional actuators on special
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systems in order to perform maintenance activities. See Section 6.5.3 Maintenance
Screen.

Figure 6.9 Rename Aux Buttons

Eﬁ Rename Aux Buttons

BRANSON

- Rename Aux Buttons

Present Name New Name

AUX1 AUX1

AUX2 AUX2
AUX3 AUX3

AUX4 AUX4

i

all

Exit the system: Touch this button to exit the VersaGraphix’s software. If the Shutdown
Windows at EXIT checkbox is checked, the system will shut down completely. If left
unchecked, the software will exit and give control to the Windows OS.

Administrator Permissions Tab

Figure 6.10 Administrator Permissions Tab

[ sdministrator.
File Run Options View Help

Options . PERMISSIONS Password List
Password Level
Admin Tech Open

‘ o L L Maintenance |
‘ (sl » o Setup |
‘ & (el . Configuration |
‘ (sl cC o Create Preset/ Sequence |
‘ (sl c o Edit Preset/ Sequence |
‘ - L o Teach Mode |

On this tab you can assign password requirements for the Maintenance, Setup,
Configuration, Create Preset/Sequence, Edit Preset/Sequence, and Teach Mode screens.
There are three possible security levels you can assign to these screens:

Open: Set the radio button to Open to make this screen accessible without a password.

Tech: Set the radio button to Tech to make this screen accessible using either the
Technician or Administrator passwords.
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Admin: Set the radio button to Admin to make this screen accessible only by using the
Administrator password.

6.5.4.3 Administrator Password List Tab

Figure 6.11 Administrator Password List Tab

File Run Options View Help

Options T Permissions PASSWORD LIST l

Administrator ‘

Technician

I Edit'Show Passwords

On this tab you may edit Both the Administrator and Technician passwords. First you must
check the Edit/Show Passwords check box, to make the passwords visible and editable.
Having this checkbox unchecked protects the passwords from being modified.

NOTICE

The default Administrator password is ADMIN.
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